iCare Population Management GUI

(BQI)

CMET User Manual

Version 2.7 Patch 1
June 2018
# Table of Contents

1.0 Introduction .............................................................................................................. 1  
  1.1 Background ........................................................................................................... 1  
  1.2 iCare Graphical User Interface ........................................................................ 1  
  1.3 Who Should Use iCare? ................................................................................... 2  

2.0 Orientation .............................................................................................................. 3  
  2.1 iCare Windows Overview .................................................................................. 3  
    2.1.1 iCare Main Window .................................................................................. 3  
    2.1.2 About the iCare Panel View Window ..................................................... 4  
    2.1.3 About the iCare Patient Record Window ............................................ 4  
  2.2 Key iCare Concepts ......................................................................................... 4  

3.0 CMET ....................................................................................................................... 6  
  3.1 CMET Workflow ............................................................................................... 7  

4.0 CMET Main View .................................................................................................. 11  
  4.1 Events Sub-Tab ............................................................................................... 11  
    4.1.1 Filter Group Box .................................................................................... 12  
    4.1.2 Events Sub-Tab Layout ........................................................................ 12  
    4.1.3 Buttons on Events Sub-Tab ................................................................... 14  
    4.1.4 CMET Batch Mammogram Screening Dialog ...................................... 20  
    4.1.5 CMET Batch Pap Smear Dialog .......................................................... 22  
  4.2 Tracked Events Sub-Tab .................................................................................. 24  
    4.2.1 Filter Group Box (Tracked Events) ....................................................... 26  
    4.2.2 Tracked Events Sub-Tab Layout ........................................................... 26  
    4.2.3 Buttons on Tracked Events Sub-Tab .................................................... 28  
  4.3 Follow-up Events Sub-Tab ............................................................................. 30  
    4.3.1 Filters Group Box (Follow-up Events) ............................................... 32  
    4.3.2 Follow-up Events Sub-Tab Layout ....................................................... 32  
    4.3.3 Buttons on Follow-up Events Sub-Tab ................................................. 33  
  4.4 CMET Worksheet ............................................................................................ 33  
    4.4.1 Patient Demographics Group Box ......................................................... 34  
    4.4.2 1 - Event Group Box ............................................................................. 34  
    4.4.3 2 - Findings Group Box ......................................................................... 35  
    4.4.4 3 - Follow-ups Group Box .................................................................... 38  
    4.4.5 4 - Patient Notifications Group Box .................................................... 40  
  4.5 Erroneously Tracked Events ........................................................................... 43  
  4.6 Using Create Button on Batch Processing Window ....................................... 45  
    4.6.1 Fields ..................................................................................................... 46  
  4.7 Add TIU Note Dialog ...................................................................................... 48  
    4.7.1 Using the Add a Note Button ............................................................... 48  

5.0 CMET Panel View .................................................................................................. 54
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.0</td>
<td>CMET Patient View</td>
<td>56</td>
</tr>
<tr>
<td>7.0</td>
<td>Standard Menus on the CMET Tab</td>
<td>59</td>
</tr>
<tr>
<td>7.1</td>
<td>File Menu</td>
<td>59</td>
</tr>
<tr>
<td>7.2</td>
<td>Tools Menu</td>
<td>59</td>
</tr>
<tr>
<td>7.3</td>
<td>View Menu</td>
<td>60</td>
</tr>
<tr>
<td>8.0</td>
<td>iCare Features Used by CMET Main Window</td>
<td>61</td>
</tr>
<tr>
<td>8.1</td>
<td>User Preferences</td>
<td>61</td>
</tr>
<tr>
<td>8.1.1</td>
<td>Startup View Tab</td>
<td>61</td>
</tr>
<tr>
<td>8.1.2</td>
<td>Layouts Tab</td>
<td>62</td>
</tr>
<tr>
<td>8.1.3</td>
<td>CMET Tab</td>
<td>63</td>
</tr>
<tr>
<td>8.2</td>
<td>Free Text Fields</td>
<td>70</td>
</tr>
<tr>
<td>8.3</td>
<td>Print Preview</td>
<td>70</td>
</tr>
<tr>
<td>8.4</td>
<td>iCare Package Manager Functions</td>
<td>73</td>
</tr>
<tr>
<td>8.4.1</td>
<td>iCare User Access Management</td>
<td>74</td>
</tr>
<tr>
<td>8.4.2</td>
<td>Reassign Panels</td>
<td>77</td>
</tr>
<tr>
<td>8.5</td>
<td>iCare Taxonomy View/Edit</td>
<td>78</td>
</tr>
<tr>
<td>8.5.1</td>
<td>Add Taxonomy Values</td>
<td>79</td>
</tr>
<tr>
<td>8.5.2</td>
<td>Remove Taxonomy Values</td>
<td>80</td>
</tr>
<tr>
<td>8.5.3</td>
<td>View Report of All Taxonomies Button</td>
<td>80</td>
</tr>
<tr>
<td>8.6</td>
<td>Pop-up Functionality</td>
<td>81</td>
</tr>
<tr>
<td>8.7</td>
<td>Taxonomy User Access</td>
<td>83</td>
</tr>
<tr>
<td>8.7.1</td>
<td>Existing RPMS Editor Access</td>
<td>83</td>
</tr>
<tr>
<td>8.7.2</td>
<td>Users with iCare Access</td>
<td>83</td>
</tr>
<tr>
<td>8.7.3</td>
<td>Taxonomy Editor</td>
<td>84</td>
</tr>
<tr>
<td>8.7.4</td>
<td>Help Menu</td>
<td>84</td>
</tr>
<tr>
<td>8.8</td>
<td>Change RPMS Server/Login</td>
<td>84</td>
</tr>
<tr>
<td>8.9</td>
<td>iCare Site Parameter Options</td>
<td>86</td>
</tr>
<tr>
<td>8.9.1</td>
<td>CMET Site Parameters</td>
<td>87</td>
</tr>
<tr>
<td>8.10</td>
<td>Manage Templates</td>
<td>89</td>
</tr>
<tr>
<td>8.10.1</td>
<td>View</td>
<td>90</td>
</tr>
<tr>
<td>8.10.2</td>
<td>Upload</td>
<td>90</td>
</tr>
<tr>
<td>8.10.3</td>
<td>Download</td>
<td>90</td>
</tr>
<tr>
<td>8.10.4</td>
<td>Delete</td>
<td>91</td>
</tr>
<tr>
<td>8.10.5</td>
<td>Edit</td>
<td>91</td>
</tr>
<tr>
<td>8.10.6</td>
<td>Add</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Glossary</td>
<td>103</td>
</tr>
<tr>
<td></td>
<td>Acronym List</td>
<td>104</td>
</tr>
<tr>
<td></td>
<td>Contact Information</td>
<td>105</td>
</tr>
</tbody>
</table>
Preface

The purpose of this manual is to provide the information needed to use the latest enhancements to the CMET functionality available in the iCare (BQI) population management application.

This manual contains reference information about iCare views, examples of its processes, and step-by-step procedures to demonstrate how to perform activities related to CMET in the latest version of the iCare application.

For more information about iCare basic functionality, iCare usage, or training for iCare consult these resources:

- iCare – Indian Health Service (IHS) Office of Information Technology (OIT): Available at http://www.ihs.gov/icare/
- iCare CMET – IHS OIT: Available at https://www.ihs.gov/icare/cmet/
- iCare Training: Available at https://www.ihs.gov/icare/training/
- Recorded AdobeConnect sessions for iCare available at https://ihs.adobeconnect.com/r6yazmoz1gm
- Join the iCare listserv by sending an e-mail to icare@listserv.ihs.gov
1.0 Introduction

The iCare application is a Windows-based, client-server graphical user interface (GUI) to the Indian Health Service (IHS) Resource and Patient Management System (RPMS). The iCare application retrieves key patient information from various components of the RPMS database and brings it together under a single, user-friendly interface. iCare is intended to help providers manage the care of their patients. The ability to create multiple panels of patients with common characteristics (e.g., age, diagnosis, community) allows users to personalize the way they view patient data.

For more information about iCare basic functionality, iCare usage, or training for iCare, consult the resources listed in the Preface.

1.1 Background

Along with the rest of the healthcare industry, IHS has developed a set of chronic condition management (or register) applications, including for diabetes, asthma, and HIV. This type of application provides a way for healthcare providers to manage a specific group (register) of patients for a single disease state. Register management applications assist healthcare providers to identify high-risk patients, proactively track care reminders and health status of individuals or populations, provide more standardized and appropriate care by embedding evidence-based guidelines, and report outcomes.

Many patients, however, have more than one diagnosed disease. For instance, at the current time within the Indian Health system, a diabetic asthmatic woman could be a member of four RPMS registers (diabetes, asthma, women’s health, and immunizations). This “silos” approach to patient care could potentially result in fragmented care and could increase the risk of inadequate patient care management due to misidentification of the true level of risk.

1.2 iCare Graphical User Interface

The iCare GUI is intended to allow providers to see a more complete view of patients with multiple conditions, while maintaining the integrity of the user-defined, disease-specific registers.

iCare can help IHS providers by:

- Proactively identifying and managing different groups (populations) of patients who share user-defined characteristics.
- Providing an integrated view of a patient’s conditions that would minimize “stove-piped” care management.
- Providing an intuitive and integrated interface to the diverse patient data elements of the RPMS database.
Facilitating providers a review of clinical quality of care measures for their own patients to enable improvement in the quality of healthcare delivery.

Enabling views of traditional healthcare information from the perspectives of community, population and public health.

Providing the default tag selection as Proposed and Accepted. Change the tag selection for any record by selecting or de-selecting any check box.

Providing the use AND? check box when multiple tags are selected. The And option searches for patients who have all of the user-defined tags.

1.3 Who Should Use iCare?

Any provider who needs to identify a group of patients for long-term management or to create a temporary list should consider using iCare.

Do you fit any of the following scenarios?

- I am a nurse at a facility that assigns a primary care provider to each patient. Every day, I want to create a list of scheduled patients for two different doctors in my clinic.

- I want to identify which of my patients are considered obese, so I can recommend nutrition counseling.

- Because providers at our clinic have performance goals related to annual GPRA clinical measures, I want to identify which of my patients are missing key clinical data.

- Our Women’s Health Clinic wants to focus on two clinical performance improvement initiatives this year. We want to identify the performance problem areas for female patients between the ages of 18 and 50.

- I am one of two part-time case managers for a group of children, and I want to create a patient list that we both can use.
2.0 Orientation

This section provides an overall look at the design and functions of the main screen elements of the iCare interface. The Care Management Event Tracking (CMET) module has a tab on each element of the iCare interface: **Main View**, **Panel View**, and **Patient View**.

The core concept of iCare is the patient panel. This panel is a list of patients that the user has defined, either manually by selecting individual patients or by using automated search definitions.

2.1 iCare Windows Overview

The iCare main window will display the namespace and RPMS server address. This aids larger sites with multiple servers. The user can quickly review which server and namespace are being accessed.

![Figure 2-1: Sample namespace and RPMS server address information](image)

2.1.1 iCare Main Window

The iCare main window contains two lists, which can be displayed on separate tabs or viewed on a split screen, as well as the following: **Community Alerts**, **National Measures**, **CMET**, and **IPC**. See other user manuals for more information about the non-CMET tabs.

![Figure 2-2: CMET tab](image)
2.1.2 About the iCare Panel View Window

The Panel View displays a list of the patients who met the panel definition criteria in a particular panel.

![Panel View](image)

Figure 2-4: Panel View

2.1.3 About the iCare Patient Record Window

The Patient Record window displays information about a selected patient from data stored in the RPMS database.

![Patient View](image)

Figure 2-5: Patient View

2.2 Key iCare Concepts

This section discusses the taxonomy concept which may have an impact on CMET events.

Many RPMS clinical applications, for example, the Diabetes Management System, the Clinical Reporting System, the PCC Health Maintenance Reminders, and iCare contain logic (artificial intelligence) statements that compare and calculate various types of patient data to arrive at a conclusion.
For example, in order for a Pap Smear Reminder to appear on the Health Summary, RPMS has to calculate the following about the patient:

- Is the patient a woman?
- If yes, does she fall into a certain age range?
- If yes, was a Pap smear ever performed?
- If yes, what is the date of the most recent Pap smear?
- If the most recent test is overdue, a reminder needs to display.

To produce results with comparable data across every facility, the clinical definition of a Pap smear has been defined nationally. Clinical definitions use RPMS taxonomies to contain the various elements of a definition. As much clinical logic as possible is based on standard national codes, including ICD, CPT, LOINC, NDC, and national IHS standard code sets (e.g., Health Factors, patient-education codes, etc.). For terminology that is not standardized across each facility, such as lab tests or medications, RPMS uses taxonomies that can be populated by each individual facility with its own codes.

For data elements like diagnoses, procedures, or lab tests identified by LOINC codes, the taxonomy simply identifies the standard codes that a software program should look for. These codes are hard-coded by a programmer into software-defined taxonomies that are distributed either in an ATX patch or with the RPMS software using those taxonomies. These taxonomies can only be updated by the software programmer or terminologist at the direction of a national clinical logic review process.

Site-populated taxonomies are used to mitigate the variations in naming convention for types of data elements that vary from one facility to another, including medications and lab tests. This means, for example, that one site’s Pap smear data can be compared to another site, even though the same term is not used for the Pap smear lab test. Or, one site’s beta-blocker data can be compared to another site, even though the same names are not used for beta-blocker drugs.

For example, one site’s Lab table might contain the term “Glucose Test,” while another site’s table might contain the term “Glucose” for the same test. PCC programs have no means for dealing with variations in spelling, spacing, and punctuation. Rather than attempting to find all potential spellings of a particular lab test, the application would look for a pre-defined taxonomy name that is installed at every facility. The contents of the taxonomy are determined by the facility. In this example, the application would use the DM AUDIT GLUCOSE TESTS TAXONOMY. The individual facility will enter all varieties of spelling and punctuation for Glucose Tests used at that particular facility.

CMET uses taxonomies to find events for the pending queue. See Appendix A for a list of CMET events and the taxonomies used for data mining.
3.0 CMET

The Care Management Event Tracking (CMET) tab on the iCare Main View window provides information on Events, Tracked Events, and Follow-up Events sub-tabs. The CMET data in the Main View includes all data that meets the filter criteria.

Figure 6: CMET Events tab

Figure 3-7: CMET Events tab
The data on the various sub-tabs are for those patients with an active HRN (Health Record Number).

The CMET tab displays the statuses of particular tests/procedures/exams on the various sub-tabs. The term “event” refers to what needs to be completed, for example, Breast Exam.

- These events are listed by category: Breast, Cervical, Colon, Liver, Prostate, Skeletal, and STI.
- The events apply to all patients meeting the data mining criteria.

If two users are working on the same CMET record, the changes that are saved first will be applied. A message to the second user is provided: “This record has just been updated. Do you want to refresh the entire list?” Click Yes to refresh (otherwise, click No).

Consider the following information:

When using the Startup View tab of User Preferences, select the desired startup view when opening iCare. Select the CMET option button on User Preferences to view a secondary field. Use this secondary field to define the default sub-tab, for example, Tracked Events. Select the Layouts tab on User Preferences to select the default template for the various CMET sub-tabs.

### 3.1 CMET Workflow

When events are mined via the iCare nightly Background Job, they show up as a Pending event in the Events tab, for evaluation to determine if the event was positive or negative, and whether it should be tracked.

![Sample Result detail and CMET Events tab row highlighted](image)

Figure 3-8: Sample Result detail and CMET Events tab row highlighted

New columns were added to show the detail information about the Event and the Result: Expanded Event and Expanded Result. The original underlined columns still open to display the result of the information.
Even events with a negative result should be tracked to indicate that someone has reviewed and verified the result, that the patient has been notified of the result, and whether a follow-up procedure has been identified.

For negative Pap smears and mammograms reports, multiple events can be batch processed because there is a set follow-up, such as another Pap or mammogram in a defined time frame in one year, two years, etc.
**Follow-up Events** become CMET Reminders when the iCare Nightly Background Job runs (or an iCare user accesses a patient’s Reminders tab in the iCare Patient Records and recalculates the Reminders for the selected patient) and can be due in the future or overdue.
Users of iCare can then create an iCare panel based on the Mammogram Screening (CMET) reminder for upcoming or overdue reminders and follow the normal process for Reminder Notifications from the Panel View – Definition details tab.
4.0 CMET Main View

This section describes the sub-tabs for the CMET main window.

4.1 Events Sub-Tab

The Events sub-tab displays all events that have been identified at your site in the routine Background Job. This can be a very large number of events; limit this display by applying filters to the view. Filtering does not affect the routine Background Job.

![Events sub-tab](image)

Figure 4-1: Events sub-tab

Events are procedures, screenings, and/or exams that are pre-defined and categorized into Breast, Cervical, Colon, Liver, Skeletal, STI, and Prostate. The occurrence of these events is searched for during a routine Background Job at your site. The most recent occurrence of any event within a certain time period is then placed on the Events tab where users can elect to either track or not track the event or leave it in a Pending status indefinitely.

The information on this sub-tab is divided into three general areas: Tips, Events data, and Filter.

The Tips segment provides an overview of the sub-tab. Collapse this information to expand the space for viewing the Events data.

The Filters area provides filters for applying filter criteria to the events data. Collapse this area to expand the available space for viewing Events data.
Note: Establish the default collapse status for the Tips and Filters areas on this sub-tab by selecting:

Tools | User Preferences | CMET tab | Events sub-tab.

Use the check boxes on the Events sub-tab to establish the collapse status.

The default filters are established on the CMET tab (Events sub-tab) of user preferences. These filters include Category, Status, TimeFrame, and Community. Section 8.1 provides more information about these filters.

Users can filter columns on the Events sub-tab. This is a temporary filter and changes will not save after exiting the application.

The initial data mining will return the most recent occurrence of every event found with an established time frame. These events are displayed on the Events sub-tab. Section 8.9.1 provides for more information about the time frames.

4.1.1 Filter Group Box

Use the filter features shown in the Filters group box. Filter the events by using one or more of the following: Category, Status, Time Frame, Community. Then, click the Get Events button to re-display the events.

Get Events: After changing the filters in the Filters group box, click the Get Events button to update the display.

Save: After changing the filters in the Filters group box, click Save to set them as the default filters. This means those filters will be in effect in another iCare session. This action changes the filters in User Preferences (on the CMET tab).

Restore to User Pref: To return to the last-saved CMET filters in User Preferences, click the Restore to User Pref button.

4.1.2 Events Sub-Tab Layout

The data on the Events sub-tab is current as of the date/time on the toolbar.
Figure 4-2: Columns on **Events** sub-tab

Table 4-1 provides information about the columns on the **Events** sub-tab.

Table 4-1: **Events** sub-tab – column Names and descriptions

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>The name of the category for the event: Breast, Cervical, Colon, Liver, Skeletal, STI, Prostate.</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Required field; links to the <strong>Events</strong> sub-tab of the <strong>CMET</strong> tab on the Patient Record by double-clicking it.</td>
</tr>
<tr>
<td>HRN</td>
<td>Patient’s Health Record Numbers.</td>
</tr>
<tr>
<td>Sex</td>
<td>F (for female), M (for male) or U (for unknown)</td>
</tr>
<tr>
<td>Age</td>
<td>Patient’s age today.</td>
</tr>
<tr>
<td>DOB</td>
<td>Patient’s date of birth.</td>
</tr>
<tr>
<td>Designated PCP</td>
<td>Designated Primary Care Provider, if any. Not all facilities use this field to empanel patients.</td>
</tr>
<tr>
<td>Community</td>
<td>Patient’s community of residence.</td>
</tr>
<tr>
<td>Active DX Tags</td>
<td>Predefined Diagnosis definitions (tags) that iCare has proposed for this patient, based on the tagging function (Proposed or Accepted).</td>
</tr>
<tr>
<td>Event Name</td>
<td>The name of the event. Events are procedures, exams, or tests that have been documented in RPMS. Events are predefined.</td>
</tr>
<tr>
<td>Expanded Event</td>
<td>Displays event information.</td>
</tr>
<tr>
<td>Event Date</td>
<td>The date associated with the event.</td>
</tr>
<tr>
<td><strong>Column Name</strong></td>
<td><strong>Meaning</strong></td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Result</td>
<td>The date of the result of the event. This cell also has hover help, which identifies where the result comes from, such as V Radiology, V Lab, or Women’s Health packages.</td>
</tr>
<tr>
<td>Expanded Result</td>
<td>Displays result information.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the event: Pending, Superseded, Tracked, or Not Tracked.</td>
</tr>
<tr>
<td>Status Comments</td>
<td>Text of the any comments about the status.</td>
</tr>
<tr>
<td>Last Modified Date/Time</td>
<td>The date the event was last modified</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>The name of the person who last modified the event (in some cases it will read “Initial job”).</td>
</tr>
</tbody>
</table>

The default sort order is as follows: **Category, Date of Event** (newest listed first), **Patient Name** (in alphabetical order).

A **Community** cell may contain the **Community Alert ( )** icon. View the Community Alert text by hovering the mouse over the icon. The icon does not affect the sorting of the **Community** column.

View the **CMET - Visit Detail** pop-up for any underlined date in the **Event Date** column by double-clicking the date.

View a particular detail pop-up for any underlined date in the **Result** column by double-clicking the date.

If there is an older event with a status of **Pending** and a new event comes in, the application changes the status of the older event to **Superseded**. This type of event cannot be tracked.

### 4.1.3 Buttons on Events Sub-Tab

Please consider the following:

In order to view an event status, change the **Status** field in the **Filters** group box. For example, if the status of an event is changed to **Tracked**, change the Status to Tracked (or All) and then click **Get Events**.

#### 4.1.3.1 Track Button

The **Track** function requires the iCare Editor (BQIZCMED) security key. Select one or more events with a status of Not Tracked or Pending and then click the **Track** button (or select **Track** on the context menu).

Once an event is Tracked, it cannot be changed to Not Tracked. If the particular event was incorrectly changed to Tracked, go to the **Tracked** tab and access the CMET worksheet for the event tracked in error.
If the user selects events that are not eligible for the Tracked function, the application displays the message: “Events having a status of Tracked can’t be changed to Tracked.” Click OK to dismiss the message.

If the user selects only one eligible event, the application displays the **RPMS iCare - Track - Findings Due Date** dialog.

![RPMS iCare - Track - Findings Due Date dialog](image1)

Figure 4-3: **RPMS iCare - Track - Findings Due Date** dialog

If the user selects more than one eligible event, the application displays the **RPMS iCare - Track - Findings Due Date** dialog for multiple events.

![RPMS iCare - Track - Findings Due Date dialog for multiple events](image2)

Figure 4-4: **RPMS iCare - Track - Findings Due Date** dialog for multiple events

In either case, do the following:

- Make sure that the correct date is in the **Findings Due Date** field (required). To change it, click the list to access a calendar and select another date. The date cannot be earlier than the current date.

- Type the text of the reason for changing the status to **Tracked** in the Free Text field (not required; see Section 8.2).

- Click **Save** to save the information (otherwise, click **Cancel**), and change the status of the events to Tracked. These events will display on the **Tracked** events sub-tab of the main window.

If using the **Save and Enter Findings** button for a single event, the application displays the CMET Worksheet (where users can add Findings to the event, for example). Section 4.4 provides for more information about the worksheet. Save the worksheet to return to the **Events** sub-tab.
4.1.3.2 Don’t Track Button

Use the Don’t Track function to change the status of a Pending event to Not Tracked. Select the events and click Don’t Track (or select Don’t Track on the context menu).

If a user selects Tracked events, they are not eligible for the Not Tracked function. In this case, the application displays the message: “Once an event has been Tracked, it cannot be changed to Not Tracked. See the User Manual guidance on how to manage an event that was tracked.” Click OK to dismiss the message. If the selected Tracked event was tracked in error, Section 4.5 provides information on how to handle this error.

If the user selected eligible events, the application displays the RPMS iCare – Don’t Track Event dialog.

![Figure 4-5: RPMS iCare – Don't Track Event dialog](image)

Type a reason for the change in the Free Text field (not required; see Section 8.2). Click OK to save and to change the Status of the events to Don’t Track. (Otherwise, click Cancel.)

4.1.3.3 Pend Button

Use the Pend button to change the status of a Not Tracked event to Pending. Select the events and click the Pend button (or select Pend on the context menu).

If the user selects events that are not eligible for the Pend button, the application displays the message: “Only events with status of Not Tracked can change to Pending.” Click OK to dismiss the message.

![Figure 4-6: Pend Function message](image)
If the user selected eligible events, the application displays the **RPMS iCare – Pend Event** dialog.

![RPMS iCare – Pend Event dialog](image)

Figure 4-7: **RPMS iCare – Pend Event** dialog

Type a reason for the change in the Free Text field (not required; see Section 8.2). Click **OK** to save and to change the Status of the events to **Pending** (otherwise, click **Cancel**.)

### 4.1.3.4 Add Manual Event

Use the **Add Manual Event** function to add manual events. The **Add Manual Event** function requires the iCare Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key.

Add a new manual event by doing one of the following:

- Click the **Add Manual Event** button.
- Select **CMET | Events | Add Manual Event**.

The **Select Patients** window displays. (This does not apply when used on the **Patient Record** screen.)

![Selected Patients dialog](image)

Figure 4-8: **Selected Patients** dialog
The **Add Manual Event** window displays.

![Add Manual Event window](image)

Figure 4-9: **Add Manual Event** dialog

The fields with an asterisk (*) following the name are required.

**Date**: Select a date for the event.

**Event**: Select the event.

**PCC File**: Select the PCC File.

**Default Value**: Select a default value for the event.

**Finding**: Select a finding, if desired for the event.

**Select Location:**

- **IHS/Tribal Facility**: Select a Location
  or

- **Other**: Enter **Outside** Location and if desired, **Outside Provider**

**Findings Comment**: Enter a comment for the finding, if desired.

Click **Save** to save a new manual event.
Click **Save and Track** to save and track a new manual event, which has the same behavior as the **Track** button (Section 4.1.3.14.4).

Use **Save, Track and Open WorkSheet** to save a new manual event, track, and open a CMET worksheet. This has the same behavior as the **Open CMET Worksheet** button (Section 4.2.3.4) on the **Tracked Events** tab.

### 4.1.3.5 Batch Processing Button

The Batch Process only applies to screening mammograms and Pap smears with normal results. This process can be applied to multiple events. Although it can be applied to one event, its purpose is to be applied to multiple events.

The CMET Package Manager sets the parameters for batch processing for the entire site. The Batch Process function requires the iCare Editor (BQIZCMED) security key.

The Batch Process works only on events that are Pending.

- If the user selects a mammogram screening or Pap smear event that is not Pending, the application displays the **Invalid Selection** message: “Please select only **PENDING Events** in order to process these as a batch.” Click **OK** to dismiss the message.

If the user selects an event that is not a mammogram screening or Pap smear, the application displays the **Invalid Selection** message: “The event type selected is not eligible for batch processing. Please reselect.” Click **OK** to dismiss the message.

Select either the mammogram screening events or the Pap smear events to batch process. Then, click the **Batch Process** button or select **Batch Process** on the context menu to batch process the selected events and to change the Status/State to **Closed**. The selected events must be of the same type of event, either all mammogram screenings or all Pap smears.

- If the user selected the mammogram screening events that are eligible for this process, the application displays the CMET Batch **Mammogram Screening** dialog. Section 4.1.4 provides for more information about this dialog.

- If the user selected the Pap smear events that are eligible for this process, the application displays the **CMET Batch Pap Smear** dialog. Section 4.1.5 provides for more information this dialog.

### 4.1.3.6 Create a Panel Button

Use the **Create Panel** function to create a panel from selected events. The patients associated with the events become the patients in the new panel. Select the events and then click the **Create Panel** button (or select **Create Panel** on the context menu) to access the **Create Panel** dialog.
Figure 4-10: Create Panel dialog

Change the name of the new panel in the New Panel Name Free Text field (Section 8.2).

Click OK to create the panel (otherwise, click Cancel). After the Create process finishes, the application displays a message: “Panel created successfully!” Click OK to dismiss the message. The new panel is listed on the Panel List window. It uses the No Predefined Population Search - Add Patients manually population search option.

4.1.3.7 Status of Background Jobs

To check on the status of the background jobs, do one of the following:

- Click the Background Jobs button.
- Select File | Background Jobs.

The RPMS iCare - Background Jobs window displays.

4.1.4 CMET Batch Mammogram Screening Dialog

The batch process for mammogram screenings changes the events to have a Status of Tracked, the Event State of Closed, and the Close Reason of Event Complete.
After completing the dialog, click **OK** to save the data. (Otherwise, click **Cancel**.)

### 4.1.4.1 Fields on the Dialog

Required fields are marked by an asterisk (*) following the field name.

**Status**: This is the status of the event (view only).

**Event Finding***: This indicates the event finding. The list contains the options to populate/change this field.

**Finding Interpretation**: This field provides the interpretation of the finding (view only).

**Follow-up Event**: This is the follow-up event (view only).

**Follow-up In***: This is the time frame for the follow-up. The list contains the options to populate/change this field.

**Notification Type***: This is the type of patient notification for the event. Select an option from the list. The options on the list are defined by the application (sites cannot add values).
Create: The Create button is active when the **Notification Type** is Letter, Certified Letter, or Telephone. This function requires an electronic signature on file. Click the Create button to access the **Add New TIU Note - Batch Mode** dialog. Section 4.6 provides for more information on this dialog.

**Notification Date**: This is the date for the patient notification. The list contains a calendar from which to select a date.

**Event State**: This shows the state of the event (view only).

**Close Reason**: This is the reason why the status is closed (view only).

**Comment**: Use this Free Text field (Section 8.2) to enter any comments pertaining to the mammogram screenings.

### 4.1.4.2 Selected Events Group Box

The **Selected Events** group box contains the selected patients for batch processing (these are the events selected for the process). This is read-only information.

![Selected Events group box](image)

Figure 4-12: **Selected Events** group box

### 4.1.5 CMET Batch Pap Smear Dialog

The batch process for Pap smears changes the events to have a Status of **Tracked**, the Event State of **Closed**, and the Close Reason of **Event Complete**.
After completing the dialog, click OK to save the data. (Otherwise, click Cancel.)

4.1.5.1 Fields on the Dialog

Required fields are marked by an asterisk (*) following the field name.

Status: This field displays the status of the event (view only).

Event Finding: This indicates the event finding (view only).

Finding Interpretation: This provides the interpretation of the finding (view only).

Follow-up Event: This displays the follow-up event (view only).

Follow-up In*: This is the time frame for the follow-up. The list contains options to populate/change this field.

Notification Type*: This is the type of patient notification for the event. Select an option from the list. The options on the list are defined by the application (sites cannot add values).
Create: The Create button is active when the Notification Type is Letter, Certified Letter, or Telephone. This function requires an electronic signature on file. Click the Create button to access the Add New TIU Note - Batch Mode dialog. Section 4.7 provides for more information about this dialog.

Notification Date*: This is the date for the patient notification. The list contains a calendar from which to select a date.

Event State: This shows the state of the event (view only).

Close Reason: This is the reason when the status is closed (view only).

Comment: Use this Free Text field (Section 8.2) to enter any comments pertaining to the Pap smear screenings.

4.1.5.2 Selected Events Group Box

The Selected Events group box contains the selected patients for batch processing (these are the events selected for the process). This is read-only information.

![Selected Events group box](image)

Figure 4-14: Selected Events group box

4.2 Tracked Events Sub-Tab

The Tracked Events sub-tab displays all events at your site that have been selected to be Tracked. This could be a very large number of events; limit this display by applying additional filters to the view. Filtering in this manner does not affect the routine background job.
Findings are abbreviated results and have been predefined for each event. Results are received and reviewed by the clinician and the appropriate Finding value is entered. Multiple Findings can be entered for each Event. Each Finding value has an associated, auto-assigned Interpretation of either Normal, Abnormal, or NA.

The CMET Worksheet is used to capture CMET activity for individual patients.

Batch Processing can be used to process multiple patients with normal results for Pap Smear or Mammogram Screenings.

The information on this sub-tab is divided into three general areas: Tips information, Tracked Events data, and Filter.

The Tips information provides an overview of the sub-tab. Collapse this information to expand the view for the Tracked Events data.

The Filters area provides filters for applying filter criteria to the tracked events data. Collapse this area to have more room for viewing the tracked events data.

**Note:** Users can set the default collapse status for the Tips and Filters areas on this sub-tab. To do so, select **Tools | User Preferences | CMET tab | Tracked Events** sub-tab. The check boxes on this sub-tab will establish the collapse status.
The default filters are established on the CMET tab (Tracked Events sub-tab) of user preferences. These filters are: Category, State, Time Frame, and Community. Section 4.2.1 provides for more information about these filters.

Users can also filter the columns on the Tracked Events sub-tab. This is a temporary filter that will be lost after the user exits the application.

### 4.2.1 Filter Group Box (Tracked Events)

Use the filter features in the Filters group box. Users can filter the events by one or more of the following: Category, State, Time Frame, and Community. Then click the Get Events button to re-display the events.

The Get Events, Save, and Restore to User Pref buttons function like those on the Events sub-tab.

### 4.2.2 Tracked Events Sub-Tab Layout

The data on the Tracked Events sub-tab is effective as of the date/time on the toolbar.

Table 4-2 provides information about the columns on the Tracked Events sub-tab.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>The name of the category for the tracked event: Breast, Cervical, Colon, Liver, Skeletal, STI, Prostate.</td>
</tr>
<tr>
<td>1 - Event</td>
<td>The name of the event. Events are procedures, exams, or tests that have been documented in RPMS. Events are predefined.</td>
</tr>
<tr>
<td>Event Date</td>
<td>The date the event was performed.</td>
</tr>
<tr>
<td>Result</td>
<td>The date the result was entered. Hover help will describe where the result came from (V-RADIOLOGY, V-LAB).</td>
</tr>
<tr>
<td>2 - Finding(s)</td>
<td>Icon that indicates if the event has any Findings.</td>
</tr>
<tr>
<td>Finding Summary</td>
<td>Summary of findings.</td>
</tr>
<tr>
<td>Interpretation</td>
<td>The interpretation of the selection in the Result field. There is hover help for this field, e.g., CMET, that refers to where the interpretation was obtained.</td>
</tr>
<tr>
<td>3 - Follow-up(s)</td>
<td>Icon that indicates if the event has any follow-up data.</td>
</tr>
<tr>
<td>4 - Patient Notification(s)</td>
<td>Icon that indicates if the event has any patient notification data.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the tracked event (open or closed). The default is OPEN.</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Required field that will link to the Tracked Events sub-tab of the CMET tab on the Patient Record by double-clicking on it.</td>
</tr>
<tr>
<td>HRN</td>
<td>Patient’s Health Record Number (required).</td>
</tr>
<tr>
<td>Column Name</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DOB</td>
<td>Patient’s date of birth (required)</td>
</tr>
<tr>
<td>Age</td>
<td>Patient’s age today.</td>
</tr>
<tr>
<td>Sex</td>
<td>F (for female) or M (for male)</td>
</tr>
<tr>
<td>Community</td>
<td>Patient’s community of residence.</td>
</tr>
<tr>
<td>Designated PCP</td>
<td>Designated Primary Care Provider, if any. Not all facilities use this</td>
</tr>
<tr>
<td></td>
<td>field to empanel patients.</td>
</tr>
<tr>
<td>Active DX Tags</td>
<td>Predefined Diagnosis definitions (“tags”) that iCare has proposed for</td>
</tr>
<tr>
<td></td>
<td>this patient, based on the tagging function (Proposed or Accepted).</td>
</tr>
<tr>
<td>Tracked By</td>
<td>The person who tracked the event.</td>
</tr>
<tr>
<td>Tracked When</td>
<td>The date the event was tracked.</td>
</tr>
</tbody>
</table>

The use of icons (check marks and feathers) on this sub-tab creates an easy-to-read review of the CMET activity display.

The **Finding(s)** cell can contain the following:

- The feather (خيل) icon indicates that a Finding entry is overdue based on the Tickler Timeframes. Hover the mouse over the icon to view the Due Date.
- The check (галיל) icon indicates that the Finding has been entered. Hover the mouse over the icon to view the Finding Due Date and the Finding Value.
- An empty cell indicates that a finding has not been entered and is not past due.

The **Follow-up(s)** cell can contain the following:

- The feather (خيل) icon indicates that a recommended follow-up entry is overdue based on Tickler Timeframes. Hover the mouse over the icon to view the Due Date.
- The check (галיל) icon indicates that a follow-up has been entered. Hover the mouse over the icon to view the Follow-up Date and the Follow-up Type.
- An empty cell indicates that a decision regarding the Follow-up has not been entered and is not past due.

The **Patient Notification(s)** cell can contain one of the following:

- The feather (خيل) icon indicates that the type of patient notification is overdue based on Tickler Timeframes. Hover the mouse over the icon to view the Due Date.
- The check (галיל) icon indicates that the type of Patient Notification has been entered. Hover the mouse over the icon to view the notification date and type.
- An empty cell indicates that the type of Patient Notification has not been entered but is not past due.
Remember that Finding(s), Follow-up(s), and Patient Notification(s) are entered on the CMET Worksheet.

If a Community cell contains the **Community Alert** ( ) icon, view the Community Alert text by hovering the mouse over the icon. The icon does not affect the sorting of the **Community** column.

View the **CMET - Visit Detail** Pop-up Functionality for any underlined date in the **Event Date** column by double-clicking the date.

Double-click the underlined date in the **Result Date** column to access a particular detail pop-up, for example, Women’s Health Detail.

### 4.2.3 Buttons on Tracked Events Sub-Tab

#### 4.2.3.1 Reopen

Use the Reopen function to change a Closed event to Open. Select only one event with a State of Closed and then click the **Reopen** button (or select **Reopen** on the context menu). The application displays the **RPMS iCare – Reopen Tracked Event** dialog.

![Figure 4-16: RPMS iCare – Reopen Tracked Event dialog](image)

Type the reason for changing the state back to Open in the Free Text field (not required; see Section 8.2 for details on pop-up functionality). When the dialog is complete, click **OK** to change the State for the event to **Open**. (Otherwise, click **Cancel**.)

If the user selects more than one event and uses the **Reopen** function, the application displays the warning message: “Please reselect as only one event can be reopened at one time.” Click **OK** to close the warning message and select only one event to continue.
4.2.3.2 Close

Use the Close function to change an Open event to Closed. Select the events with a State of Open and then click the Close button (or select Close on the context menu). The application displays RPMS iCare – Reason for Closing dialog.

![RPMS iCare – Reason for Closing dialog](image)

Figure 4-17: RPMS iCare – Reason for Closing dialog

Required fields are marked by an asterisk (*) following the field name.

**Reason**: Select an option from the list—Event Complete, Patient Moved, Lost to Follow-up, Other (this option requires a comment).

**Comment**: This Free Text field (Section 8.2) is required when the Reason is set to Other. Type the text of the reason.

When the dialog is complete, click OK to change the State for the selected events to Close. (Otherwise, click Cancel.)

4.2.3.3 Batch Process

The Batch Process only applies to screening mammograms and Pap smears with normal results. This process works on Open events that have empty (no ticklers or check marks) in the Findings, Follow-up, and/or Patient Notifications columns.

If the user selects events that are not eligible for the Batch Process, the application displays the message: “Please select only Tracked Events without Findings, Follow-ups, or Notifications in order to process these as a batch.” Click OK to dismiss the message.

Select one or more eligible events and click the Batch Process button (or select Batch Process on the context menu).

For mammogram screenings, Section 4.1.4 for more information.

For Pap smears, Section 4.1.5 provides for more information.
4.2.3.4 Open CMET Worksheet

Select an event and then click the **Open CMET Worksheet** button (or select **Open CMET Worksheet** on the context menu) to access the CMET Worksheet (for the event). Enter Finding(s), Follow-up(s), and Patient Notification(s) for the event. Section 4.4 provides for more information about the worksheet.

**Note:** This function can be applied to only one event.

4.2.3.5 Create Panel

Use the **Create Panel** function to create a panel from the selected events. The patients associated with the events become the patients in the new panel. Select the events and then click the **Create Panel** button (or select **Create Panel** on the context menu).

4.2.3.6 Status of Background Jobs

To check on the status of the background jobs, do one of the following:

- Click the **Background Jobs** button
- Select **File** \| **Background Jobs**

The **RPMS iCare - Background Jobs** dialog displays.

4.3 Follow-up Events Sub-Tab

The **Follow-up Events** sub-tab contains events with a recommended follow-up. This sub-tab displays all of the follow-up events at your site that have been generated by all CMET users. This can be a very large number of events; limit this display by applying filters to the view. Filtering in this manner does not affect the routine background job.
Figure 4-18: **Follow-up Events** sub-tab

Follow-up is the clinician's recommendation for what the next step will be, whether that is routine screening or further diagnostic studies. Multiple recommendations for Follow-up can be entered. This recommendation initiates a CMET Reminder.

The information on this sub-tab is divided into three general areas: Tips information, Follow-up Events data, and Filter.

The Tips information provides an overview of the sub-tab. Collapse this information to expand the view the Follow-up Events data.

The Filters area provides filters for applying filter criteria to the follow-up events data. Collapse this area to expand the view the follow-up events data.

**Note:** Establish the default collapse status for the Tips and Filters areas on this sub-tab. To do so, select **Tools | User Preferences | CMET tab | Follow-up Events** sub-tab. The check boxes on this sub-tab will establish the collapse status.

Users can also change the filters on the columns on the **Follow-up Events** sub-tab. This is a temporary filter and will be lost when the user exits the application.
4.3.1 Filters Group Box (Follow-up Events)

Use the filter features shown under the Filters group box. Users can filter the events by using one or more of the following: Category, Time Frame, Community. Then, use the Get Events button to redisplay the events. Section 4.1.1 provides for more information about using the filters.

The Get Events, Save, and Restore to User Pref buttons work like those on the Events sub-tab. Section 4.1.3 provides for more information about this sub-tab.

4.3.2 Follow-up Events Sub-Tab Layout

The data on the Follow-up Events sub-tab is effective as of the date/time on the toolbar. Users can sort/filter the columns and perform other functions on the columns.

Table 4-3 provides information about the columns on the Follow-up Events sub-tab.

Table 4-3: Follow-up sub-tab column names and meanings

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>The name of the category for the follow-up event: Breast, Cervical, Colon, Liver, Skeletal, STI, Prostate.</td>
</tr>
<tr>
<td>Follow-up Event Name</td>
<td>The name of the event. This is the recommended follow-up entered in CMET.</td>
</tr>
<tr>
<td>Follow-up Event Date</td>
<td>The date of the recommended follow-up.</td>
</tr>
<tr>
<td>Preceding Event</td>
<td>This is the date of the preceding event. When a user double-clicks on the underlined date, the application opens to the Tracked Events of the CMET tab on the Patient Record. The chain of events in the same category is revealed. In addition, there is hover help when moving the mouse over the date (for example, PAP SMEAR).</td>
</tr>
<tr>
<td>Patient Name</td>
<td>Patient’s name.</td>
</tr>
<tr>
<td>HRN</td>
<td>Patient’s Health Record Number.</td>
</tr>
<tr>
<td>DOB</td>
<td>Patient’s date of birth.</td>
</tr>
<tr>
<td>Age</td>
<td>Patient’s current age.</td>
</tr>
<tr>
<td>Sex</td>
<td>F (for female) or M (for male)</td>
</tr>
<tr>
<td>Community</td>
<td>Patient’s community of residence.</td>
</tr>
</tbody>
</table>

If a Community cell contains the Community Alert (闲置) icon, view the Community Alert text by hovering the mouse over the icon. The icon does not affect the sorting of the Community column.

Double-click any event (not on the Preceding Event cell), and the application displays the CMET Worksheet for the event. Section 4.4 provides more information about the worksheet.
4.3.3 Buttons on Follow-up Events Sub-Tab

The Create Panel, Open CMET Worksheet, and Status of Background Jobs buttons work like those on the Tracked Events sub-tab. Section 4.2.3 provides more information on the buttons.

4.4 CMET Worksheet

Use the Open CMET Worksheet button to access the CMET Worksheet for a selected event on the particular sub-tab of the CMET window. Find this button on the Tracked Events and Follow-up Events sub-tab on the CMET main window.

Use this worksheet to process the Care Management Events to track. Enter data related to Findings, Follow-up, and Patient Notification. The Site parameters Due By default dates set by the CMET Package Manager can also be edited in this screen.

Figure 4-19: CMET Worksheet dialog

When the worksheet is complete, click OK (otherwise, click Cancel).
After clicking **OK**, there are two cases:

- Case 1: If not all of the steps are complete, the application updates the data on the **Tracked Events** sub-tab.
- Case 2: If all of the steps are complete, the application displays the **Close Event** information message that states: “The event is eligible for closing as all four steps are completed. Do you want to close the event now?” Click **Yes** to close the event. Click **No** to keep the event open.

Close the event (by selecting **Yes** on the **Close Event** message) and the application displays the **RPMS iCare Reason for Closing** dialog. Select a reason for closing the event and provide a comment (required) about the closing. Click **OK** to save the reason for closing (otherwise, click **Cancel**).

After clicking **OK** on the **Reason for Closing** dialog, the application displays the **Save to RPMS?** dialog: “You have data changes pending. Do you want to save to RPMS now?” Click **Yes** to save the changes to RPMS. Click **No** to discard the changes.

After clicking **Cancel**, there are two cases:

- Case 1: If there are no changes on the worksheet, the application closes it.
- Case 2: If there are changes on the worksheet, the application displays the **Save to RPMS?** dialog: “You have data changes pending. Do you want to save to RPMS now?” Click **Yes** to save the changes to RPMS. Click **No** to discard the changes. Click **Cancel** to return to the CMET Worksheet.

### 4.4.1 Patient Demographics Group Box

The **Patient Demographics** group box shows the patient’s name, HRN, Sex, Age, and DOB.

### 4.4.2 1 - Event Group Box

The data in the **1 – Event** group box provides information about the event and allows users to change the State of the event, as well as provide comments about the Event and/or State. In addition, users can view the audit history of the event.

![Figure 4-20: 1 – Event group box](image)

**State**: This field defines the State of the event.
If the user populates the State field with Closed, the Close Reason field becomes active. Select an option from the list that describes the reason for closing the event.

When an Event has a State of Closed, the other group boxes (Findings, Follow-up, Patient Notifications) will be inactive.

**Event Comment**: Use this Free Text field to add comments about the Event.

**State Comment**: Use this Free Text field to add comments about the State.

**Note**: See Section 8.2 for more information on Free Text fields.

**CMET Audit History**: If the user clicks the View label, the application will display the CMET Audit History pop-up.

![CMET Audit History](image)

Figure 4-21: CMET Audit History pop-up

Because multiple users work on events, the Audit History provides a history of those activities.

**State**: This determines the state of the event, either Open or Closed. If the state is set to **Closed**, the Close Reason field becomes active.

If the state is Closed, all of the other group boxes (2 - Findings, 3 - Follow-ups, 4 - Patient Notifications) become inactive.

**Close Reason**: This field is active when the State is **Closed**. Select an option from the list that provides the reason for closing the event.

### 4.4.3 2 - Findings Group Box

Use the 2 – **Findings** group box to enter Findings data about the event.
Minimize this group box by clicking the collapse button in the upper left corner. This allows more room for viewing the other group boxes (e.g., Follow-ups and Patient Notifications).

Populate the Findings Due By, Result, and Follow-up Recommended? fields by using the Add button on the grid and saving the record.

**Findings Due By:** This field displays the date the findings of this event are due. If this date passes without an entry, a Tickler (a reminder marked by a Feather icon) is generated.

**Result:** This field displays the date of the result. If this field contains an underlined date, click on the date to display the detail of the result. For example, below is the Radiology Case Number Detail pop-up (see Section 8.6 for pop-up functionality).

**Follow-up Recommended?:** This field indicates if follow-up is recommended (Yes or No).

### 4.4.3.1 Add Button

Use the Add button to create a new Findings record. Click the Add button (or press F2 on the keyboard) to access the Findings dialog.
Required fields are marked by an asterisk (*) following the field name.

**Date***: Click the box and select a date for the finding.

**Finding***: This is the finding associated with the event. Use an option from the list to populate this field.

**Interpretation**: The application populates this field, based on the selection in the **Finding** field.

**Comment**: Type the text of the comments about the Finding, if appropriate, in this Free Text field (Section 8.2).

**Follow-up Needed**: Use an option from the list: **Yes** or **No**.

Click **OK** to save the data on the **Findings** dialog (otherwise, click **Cancel**).

After saving the data, the application populates the grid with the record and populates the **Last Edited** (current logon user) and **Last Edited By** (current date) columns.

Saving and selecting **Yes** for the **Follow-up Needed?** field on the **Findings** dialog will cause the **Follow-up Recommended?** field on the grid to be populated with **Yes**. The application will automatically display the Follow-Ups dialog (where users can enter follow-up data).

### 4.4.3.2 Delete Button

The **Delete** function applies to events that had Findings entered but **not** saved.

If the user selects an event that is not eligible for the **Delete** function, the application displays the message: “Unable to delete a previously saved entry. Please mark as ‘Entered in Error’ instead.” Click **OK** to dismiss the message.
Select one or more eligible Findings records to delete and click the Delete button (or press the Delete button). The application displays the Delete Row information message, confirming the deletion. Click Yes to delete the selected records. Otherwise, click No.

### 4.4.3.3 Error Button

Use the Error button when Findings records have been saved and cannot be deleted but should be marked as Entered in Error.

If the user selects a record that is not eligible for the Error function, the application displays the message: “Unable to mark as ‘Entered in Error’ because the entry has not been saved in RPMS. Please delete the entry instead.” Click OK to dismiss the message.

Select one or more eligible Findings records and click the Error button. After using this function, the application places a strikethrough mark on the record text.

![Figure 4-25: Entered in Error example](image)

After saving and returning to the Tracked Events tab, the Result column for the event will be blank for the particular event.

### 4.4.4 3 - Follow-ups Group Box

Use the 3 – Follow-ups group box to add follow-up data about the event.

![Figure 4-26: 3 – Follow-ups group box](image)

The Follow-ups group box becomes active when the Follow-up Recommended field (in the Findings group box) is set to Yes.

Minimize this group box by clicking the collapse button in the upper left corner. This allows more room for viewing the other group box (e.g., Patient Notifications).
Follow-up Decision Due By: Select a date from the list that indicates when the follow-up decision should be made. Populating the field creates a tickler (Feather icon) for the event. In certain cases, this date is populated by the Tickler Timeframe set in the site parameters. Populate this field with the date to take action on the event.

4.4.4.1 Add Button

Use the Add button to create a new Follow-up record. Click the Add button (or press F2) to access the Follow-Ups dialog.

![Follow-Ups dialog](image)

Figure 4-27: Follow-Ups dialog

Required fields are marked by an asterisk after the field name.

**Event**: Select an option from the list that describes the Event for the follow-up.

**Date Due**: Use the list to display a calendar from which to select the due date for the follow-up event.

**Comment**: Type text in this Free Text field (Section 8.2) to add comments about the follow-up.

Click **OK** to save the data on the dialog (otherwise, click **Cancel**). After saving, the follow-up record will display in the 3 - Follow-ups group box on the CMET Worksheet.

4.4.4.2 Delete Button

The Delete function applies to events that had Follow-ups entered but *not* saved.

Select one or more eligible Follow-up records to delete and click the Delete button (or press the Delete button on the keyboard). The application displays the Delete Row information message, confirming the deletion. Click **Yes** to delete the selected records. Otherwise, click **No**.
4.4.4.3 Error Button

Use the Error button when Follow-up records have been saved and cannot be deleted but should be marked as Entered in Error.

If the user selects a record that is not eligible for the Error button, the application displays the message: “Unable to mark as ‘Entered in Error’ because the entry has not been saved in RPMS. Please delete the entry instead.” Click OK to dismiss the message.

Select one or more eligible Follow-up records and click the Error button. After using this function, the application places a strikethrough mark on the text of the record.

Figure 4-28: Follow-up record marked as entered in error

4.4.5 4 - Patient Notifications Group Box

Use the 4 – Patient Notifications group box to add patient notification data about the event.

Figure 4-29: 4 – Patient Notifications group box

The Patient Notification, the final step, alerts the patient of both the results and the recommendations for follow-up. Multiple types of Patient Notifications can be entered for each Event.

The Patient Notifications group box becomes active when a finding is entered in the Findings group box.

Minimize this group box by clicking the collapse button in the upper left corner. This allows more room for viewing the Follow-ups group box.

Notification Due By: Enter the date to notify the patient about the results and recommendations of the follow-up related to this event. If this date passes without an entry, a tickler (feather) icon will be generated. In certain cases, this date is populated by the Tickler Timeframe set in the site parameters.
4.4.5.1 Add Button

If a default clinic is not defined in user preferences, the application displays the following message: “You must select default clinics in user preferences before being able to enter notes.” Click OK to dismiss the message. Select Tools | User Preferences to access the RPMS iCare – User Preferences dialog. Click the Patient View tab to enter the clinic codes.

Use the Add button to create a new Patient Notification record. Click the Add button (or press F2) to access the Notifications dialog.

![Notifications dialog](image)

Figure 4-30: Notifications dialog

Required fields are marked with an asterisk (*) after the field name.

**Date**: The default date is today’s date. Change it by clicking the list to access a calendar and select another date.

**Method**: Select an option from the list that identifies the type of notification.

**Create**: This button becomes active when selecting Certified Letter, Letter, or Telephone in the Method field. An electronic signature must be on file before using this function.

If an electronic signature is on file, click the Create button to access the Add TIU Note dialog.

**Comment**: Use this Free Text field (Section 8.2) to add any comments about the notification.

After completing this dialog, click OK to save the data (otherwise, click Cancel). After saving, the notification record will display in the 4 - Patient Notifications group box on the CMET Worksheet.
4.4.5.2 **Delete Button**

The Delete function applies to events with Patient Notifications entered but *not* saved.

Select one or more eligible Patient Notification records to delete and click the **Delete** button (or press Delete on the keyboard). The application displays the **Delete Row** information message, confirming the deletion. Click **Yes** to delete the selected records. Otherwise, click **No**.

4.4.5.3 **Error Button**

Use the **Error** button when Patient Notification records have been saved and cannot be deleted and need to be marked as Entered in Error.

If the user selects a record that is not eligible for the Error function, the application displays the message: “Unable to mark as ‘Entered in Error’ because the entry has not been saved in RPMS. Please delete the entry instead.” Click **OK** to dismiss the message.

Select one or more eligible Patient Notification records and click the **Error** button. After using this function, the application displays a strikethrough mark on the text of the record.

![Image of Patient Notification record marked as entered in error](image)

Figure 4-31: Patient Notification record marked as entered in error

4.4.5.4 **Preview**

Use the Preview function to preview the letter associated with the selected Patient Notification record. This function only applies to records that are Letters, Certified Letters, or Telephone.

Select the record to preview and click the **Preview** button. The application displays the **Letter Preview** pop-up (see Section 8.6 for pop-up functionality).
4.4.5.5 Print Button

Use the Print button to output a letter in a selected record. After clicking Print, the application displays the Print dialog where the user specifies the printer, page range, number of copies, etc.; this dialog works like the one in Microsoft Office.

4.5 Erroneously Tracked Events

Once an event has been Tracked, it cannot be changed to Not Tracked. Use the following process when an event is erroneously Tracked.

1. Go to the Tracked tab, in any view (Main, Panel, Patient Record) and open a CMET worksheet for the event erroneously tracked. Click the Add button in the Findings area to access the Findings dialog.

   Select the ERROR/DISREGARD option in the Findings field. Select the option No in the Follow-Up Needed? field. Use today’s date for the Date field. Click OK to save and close the dialog.
2. Go to the **Patient Notifications** area of the CMET Worksheet and click the **Add** button. The application displays the **Notifications** dialog.

![Notifications dialog populated](image)

Use the **NONE** option for the **Method** field. It is recommended to add a comment in the **Comment** field (such as “entered in error”) and to use today’s date for the **Date** field. Click **OK** to save and close the dialog.

3. The application will display the **Close Event** information message.

![Close Event information message](image)

Click **Yes** to close the message.

4. The application will display the **RPMS iCare – Reason for Closing** dialog.
Select the option Other for the Reason field. Enter a comment in the Comment field. Click OK to save and to close the dialog.

5. The application will display the Confirm save to RPMS information message.

Click Yes on the message to save the data to RPMS and close the message.

This process causes the particular event to have a State of Closed.

4.6 Using Create Button on Batch Processing Window

On the CMET Batch Mammogram Screening or CMET Batch Pap Smear window, click the Create button to access the Add TIU Note – Batch Mode dialog.
4.6.1 Fields

Both fields are required.

**Document Title**: Select an option from the list to establish the title of the TIU note.

**Subject**: Use this Free Text field (Section 8.2) to enter the subject of the TIU note.

At this point, the user can do one of the following: not use a template (see Section 4.7.1.1 for details) or use a template (see Section 4.7.1.2 for details).

4.6.1.1 Buttons

The **Find**, **Font**, **Copy**, **Print Preview**, and **Print** buttons on this dialog work like those on the pop-up window (see Section 8.6).

Adjust the font size before saving the note. Using this process will save the note in an appropriate font size for output (later).

**Save Note**: Click this button to save the current note.

**Delete Note**: Click this button to delete the current unsigned note. This button does not apply to signed notes.

**Edit Note**: Click this button to edit the text of an unsigned note.

**Close**: Click this button to close the **Add TIU Note – Batch Mode** dialog.

After clicking the **Close** button, the application closes the **Add TIU Note – Batch Mode** dialog.

Then the application displays the **Enter Electronic Signature** dialog.
Enter the electronic signature in the **Please sign** field and click **OK** (otherwise, click **Cancel**).

### 4.6.1.2 Printing the TIU Note

Click **OK** on the **Enter Electronic Signature** dialog, and the application displays the **Print TIU Notes** information message.

Figure 4-40: **Print TIU Notes** information message

Click **Yes** to print the TUI note. The application displays the **Print Preview** dialog. Print the TUI note from this dialog.

Click **No** to not print the TUI note. The application displays the **Print TIU Notes** information message. This presents a second opportunity to print the TUI note.

Figure 4-41: **Print TIU Notes** information message

Click **Yes** to print the TIU note at this time when batch processing. Otherwise, reprinting the note will only be available from the individual patient record.

Click **Yes**, and the application displays the **Print Preview** dialog. Print the TIU from this dialog.
4.7 Add TIU Note Dialog

The following information provides information about using the Add TIU Note dialog.

4.7.1 Using the Add a Note Button

Click the Add Note button to display the Add a Note dialog.

Click the Create button on the Add a Note dialog to display the Add TIU Note dialog.

![Add TIU Note dialog](image)

Both fields are required.

**Document Title**: Select an option from the list to establish the title of the TIU note.

**Subject**: Use this Free Text field (Section 8.2) to enter the subject of the TIU note. This field becomes active after populating the Document Title field.

At this point, do one of the following: do not use a template (Section 4.7.1.1) or use a template (Section 4.7.1.2).

4.7.1.1 Note with No Template

Populate the **Document Title** and **Subject** fields, then type the text of the TIU note in Free Text area (Section 8.2) on the right side of the dialog.

When the text is complete, the following buttons are active: **Find**, **Font**, **Copy**, **Save Note**, **Sign Note**, **Close**. Section 4.7.1.3 provides for more information.

Figure 4-43 shows an example of the note after clicking the **Save Note** button.
4.7.1.2 Note with Template

After populating the Document Title and Subject fields, select the Show Template? check box. This action displays the available templates. (Expand the Shared Templates option.) Find the appropriate template and double-click on its name to use it. The application will display the selected template.
Complete the template by using the buttons and check boxes on the template. The information completed on the template determines the text of the TIU note.

Click the **Preview** button on the **Template** window to preview the note in its current state.

What appears on the **Template Preview** pop-up determines what will be in the text of the TIU note. Close (select **File | Close**) the pop-up and return to the **Template** window.
After completing the **Template** window, click **OK** (otherwise, click **Cancel**), and return to the **Add TIU** dialog.

### 4.7.1.3 Buttons on Add TIU Note Dialog

Please note the following about the text of the TIU note:

- Line lengths should be less than 80 columns (characters), otherwise, the line spacing on the finished TIU note will not format correctly.
- The **Find**, **Font**, **Copy**, **Print Preview**, and **Print** buttons on this dialog work like those on the pop-up window (see Section 8.6 for pop-up functionality).
- Adjust the font size before saving the TIU note, if needed.

**Delete Note**: Click this button to delete the current unsigned note. (This button does not apply to signed notes.)

**Save Note**: Click this button to save the current note. After clicking the **Save Note** button, the note is saved, and the **Delete Note** and **Edit Note** buttons become active.

**Sign Note**: Click this button to electronically sign the selected unsigned TIU note. After clicking the **Sign Note** button (or selecting **File** | **Sign Note**), the application displays the **Enter Electronic Signature** dialog.

![Image of Enter Electronic Signature dialog]

Figure 4-46: **Enter Electronic Signature** dialog

Enter the electronic signature in the Free Text field (Section 8.2) and click **OK** (otherwise, click **Cancel**). After clicking **OK**, the user returns to the **Add TIU Note** dialog. The text of the note shows that the note has been electronically signed.

![Image of signed text in note]

Figure 4-47: Electronic signature noted on text of TIU note

**Edit Note**: Click the **Edit Note** button to display the text of the note.
The patient is very allergic to ray weed.

Figure 4-48: Example of note text

After editing the text of the note, click the **Save Note** button.

If the TIU note is signed, users cannot change the text; users can only view the text.

**Close**: Click this button to close the **Add TIU Note** (for patient) dialog. Click the **Close** button (or select **File** | **Close**) to close the dialog.

Return to the **Add a Note** dialog, with the **Preview** button next to the **Add Note** field.

Figure 4-49: **Add a Note** dialog with **Preview** button

Click the **Preview** button to display the note text.

Figure 4-50: **Letter Preview** pop-up
Close the pop-up (see Section 8.6 for pop-up functionality) to return to the **Add a Note** dialog (with the **Preview** button on it).

After the **Add a Note** dialog is complete, click **OK** (otherwise, click **Cancel**).

After the user clicks **OK**, the application displays the **Enter Electronic Signature** dialog.

![Figure 4-51: Enter Electronic Signature dialog](image)

Enter the electronic signature in the Free Text field (Section 8.2). After completing the dialog, click **OK** (otherwise, click **Cancel**).

- If the user enters an invalid electronic signature and clicks **OK**, the application displays the **Invalid Attempt** information message: “Invalid electronic signature. Try again?” Click **Retry** to return to the **Enter Electronic Signature** dialog. Click **Cancel**, and the application displays the message: “Unable to save with a signed note.” Click **OK** to return to the **Add a Note** dialog.

- Click **Cancel**, and the application displays the message: “Unable to save with a signed note.” Click **OK** to dismiss the message.

- If the user enters a valid electronic signature and clicks **OK**, the application displays the information message: “This data will be saved to the RPMS server. Do you want to continue?” Click **Yes** to save and continue. Click **No** to discard the note and exit the dialog.
5.0 CMET Panel View

The Care Management Event Tracking (CMET) tab on the Panel View window provides the same view as CMET Main View, including information on Events, Tracked Events, and Follow-up Events sub-tabs by only the patients in this selected panel.

The functionality is the same as Main View. Review Section 3.0 for more details on the CMET functionality.

![Figure 5-1: Events sub-tab](image1)

![Figure 5-2: Tracked Events sub-tab](image2)
Figure 5-3: **Follow-up Events** sub-tab
6.0 CMET Patient View

The CMET Patient View is similar to the main view and the Panel View, with information on Events, Tracked Events, and Follow-up Events sub-tabs by the selected patient. In addition, Patient View has a fourth sub-tab, called Past Events.

Figure 6-1: CMET Patient View – Events sub-tab
Figure 6-2: CMET Patient View – **Tracked Events** sub-tab

Figure 6-3: CMET Patient View – **Follow-up Events** sub-tab
Past Events are all the CMET Events that have been data mined for the selected patient. It can be used to review historical information on this patient.

Table 6-1 provides information about the columns on the Past Events sub-tab.

Table 6-1: Past Events sub-tab column names and meanings.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>The name of the category for the follow-up event: Breast, Cervical, Colon, Liver, Skeletal, STI, Prostate.</td>
</tr>
<tr>
<td>Event Name</td>
<td>The name of the event. Events are procedures, exams, or tests that have been documented in RPMS. Events are predefined.</td>
</tr>
<tr>
<td>Event Date</td>
<td>The date associated with the event.</td>
</tr>
<tr>
<td>Result</td>
<td>The date of the result of the event. This cell also has hover help, which identifies where the source of the result such as V Radiology, V Lab, or Women’s Health packages.</td>
</tr>
<tr>
<td>Interpretation</td>
<td>The interpretation of the selection in the Result field. There is hover help for this field, e.g., CMET, that refers to where the interpretation was obtained. The interpretation will be from either Women’s Health or from a tracked CMET Event where the Finding has been entered. All CMET Findings have an interpretation.</td>
</tr>
</tbody>
</table>
7.0 Standard Menus on the CMET Tab

7.1 File Menu

The File menu has the following options:

**CMET**: This shows various options depending on the current sub-tab.

**Change RPMS Server/Login**: This option allows users to change access and verify codes to the iCare application on the iCare Login dialog. See section 8.8 for details.

**Change RPMS Division**: This option allows users to change the RPMS Division on the Select Division dialog. This option applies to a site that uses more than one RPMS database.

**Recent Panels**: This sub-menu displays recent panels. Select one to view the patients in the selected panel in a new window. The list includes the last five panels viewed.

**Page Setup**: This option allows users to set Margin, Paper, Layout characteristics (such as landscape or portrait orientation) and which Printer to use. These settings are used when using the Print option.

**Print Preview**: This option displays the print preview dialog. See Section 8.3 for details.

**Print**: This option sends the selected rows to the printer using the settings in Page Setup. Note that only the selected tab will be printed.

**Background Jobs**: This option displays the Background Jobs pop-up. This pop-up displays, for example, the start and end dates for the monthly and weekly background jobs.

**Exit iCare**: This option exits the iCare application. Users are prompted to save any changed panels if necessary.

**Lock iCare**: This option allows users to lock the iCare application. Resume the application by entering your verify code on the iCare Locked By dialog and clicking Resume.

7.2 Tools Menu

The options on the Tools menu are the same as those on the Tools menu for the Panel List window.

**Quick Patient Search**: Search for a patient name. This is the same function as pressing F8 on the keyboard.
The **Mail Merge**, **Reset View**, **Search**, **Refresh**, **Excel Export**, **Print**, and **Copy Rows to Clipboard** options function like the buttons on the right side of the window.

**Manage Templates**: This option opens the **Template Management** dialog where you manage your templates and public templates. See Section 8.10 for more details.

**User Preferences**: This option opens the **User Preferences** window. See Section 8.1 for details.

**View iCare Notifications**: This option opens the **iCare Notifications** pop-up.

**iCare Package Manager**: This option is active for those users with Package Manager security key. See Section 8.4 for more details.

**iCare Site Parameters**: This option allows users to set site parameters for Employers, Pregnancy, Inactivity Time Out, CMET Site Parameters, IPC Site Parameters, Divisions, DM Audit. See Section 8.9 for more details.

**Taxonomy Maintenance**: This option is used by those users who can maintain taxonomies. Also use this option to view the taxonomy elements. This option has the following two features: **View/Edit Taxonomies** (Section 8.5) and **Taxonomy User Access** (Section 8.7).

**Web Links**: This option provides links to Web sites for related clinical guidelines.

### 7.3 View Menu

The **View** menu has one option:

**Split View**: When this option is checked, the current view is the split view. Switch back to the CMET tab by removing the check mark; this is a temporary setting. After exiting and reopening iCare, the settings established in User Preferences (Section 8.1) are used for the default view.
8.0 iCare Features Used by CMET Main Window

The following provides information about using the iCare features for the CMET main window.

8.1 User Preferences

This section focuses on the user preferences for the CMET main window.

![User Preferences dialog](image)

Figure 8-1: **User Preferences** dialog

After the User Preferences window is complete, click **OK** and the user preferences will be in effect for the operation of the iCare application. Otherwise, click **Cancel**.

8.1.1 Startup View Tab

The selection on **Startup View** tab determines which tab will display when first accessing the iCare application.
Select the **CMET** option button to set the CMET main window as the first window to display when accessing the iCare application. In addition, select the sub-tab to display (**Events** is the default). Select an option from the list to change the sub-tab.

### 8.1.2 Layouts Tab

The **Layouts** tab on **User Preferences** determines the default template used by the various CMET sub-tabs.
8.1.3 CMET Tab

The CMET tab determines the user preferences for the Events, Tracked Events, and Follow-up Events sub-tabs of the CMET Main View tab.

Figure 8-3: User Preferences dialog – Layouts tab
Figure 8-4: **Main View** tab features

After changing the settings on any of the three sub-tabs, click **OK** to save the changes (otherwise, click **Cancel**).

**Restore to System Default Button.**

Click the **Restore to System Default** button to return to the system default settings. This button is available on all CMET sub-tabs.

**Collapse Tips Display**

Select the **Collapse Tips Display** check box to collapse the Tips of the particular sub-tab (you will not be able to view the various tips). This check box is available on all of the CMET sub-tabs.

**Collapse Filters Display**

Select the **Collapse Filters Display** check box to collapse the **Filter** group box of the particular sub-tab (you will not be able to view the various filters). This check box is available on all of the CMET sub-tabs.

**Status**

Use the **Status** field to filter the displayed events to those with a particular status. Click the list and select an option to populate the **Status** field. The **Status** field is not available on the **Follow-up Events** sub-tab.
**Time Frame**

Use the **Time Frame** field to filter the displayed events to those in a particular time frame. Click the list and select an option to populate the **Time Frame** field. This field is available on all of the CMET sub-tabs.

### 8.1.3.1 Events Sub-tab

This information applies to the **Events** sub-tab for the CMET main view.

![Events sub-tab options](image)

The **Events** sub-tab displays all events that have been identified at your site in the routine background job. This can be a very large number of events; limit this display by applying filters to the view. Filtering in this manner does **not** affect the routine background job.

Use the **Events** sub-tab to establish the filters for the current events on the CMET main window.

Use the **Tracked Events** sub-tab to establish the filters for the tracked events on the CMET main window.

Use the **Follow-up Events** sub-tab to establish the filters for the follow-up events on the CMET main window.

All three sub-tabs have the same features.
8.1.3.1.1 Category

Use the Category field to filter the displayed events to those in one or more categories. To populate the Category field, click the Edit button to access the Add/Remove Events Category dialog. The default Category field includes Breast, Cervical, Colon, Liver, Skeletal, STI, and Prostate.

Figure 8-6: Add/Remove Events Category dialog

Available Selections

Use the Find field to locate a particular event category name by using the two search option buttons: Starts With determines what the event category name starts with and Contains determines any of the characters in the event category name. These option buttons assist users when the Available Selections list is quite long.

To move a selected category name from the Available Selections list to the Current Selections list, click Add.

Current Selections

Use the Find field to locate a particular event category by typing a few characters of the event category name. The application will scroll the list to the first found name.

To move a selected category name from the Current Selections list to the Available Selections list, click Remove.

The options in the Current Selections field determines the default Category for the Events (Tracked Events, Follow-up Events) sub-tab on the CMET main window.

8.1.3.1.2 Community

Use the Community field to filter the displayed events to those in a community either by taxonomy or by name.
Select one of the option buttons to use as a filter for the events.

**By Name Option Button**

Use the **By Name** option button to define the communities to filter the events.

Use the field below the option buttons to filter the communities in the lower field. The options are (1) **With At Least One Patient** or (2) **All**.

Use the **Edit** button to add one or more names to the lower field. Click the **Edit** button to access the **Add/Remove Communities** dialog.

**Available Selections**

The **Available Selections** option determines the patient population for a community by name. Select an option from the list to change this field.

Section 8.1.3.1.1 provides information on how to use the **Available Selections** and **Current Selections** group boxes.
When the **Add/Remove Communities** dialog is complete, click **OK** and this populates the lower field with the names of the communities shown in the **Current Selections** group box. (Otherwise click **Cancel**.)

If the lower field contains more than one community, this activates the **Create Taxonomy** button. To use the **Create Taxonomy** button, the user must have the iCare Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key.

![Community group box with active Create Taxonomy button](image)

**Figure 8-9:** Community group box with active Create Taxonomy button

Use the **Create Taxonomy** button to save the listed communities as a Community taxonomy. Click the **Create Taxonomy** button to display the **Create/Update Community Taxonomy** dialog.

![Create/Update Community Taxonomy dialog](image)

**Figure 8-10:** Create/Update Community Taxonomy dialog

Use the **Community Taxonomy Name** field (required) to specify a taxonomy name for the list of communities. Use the **Brief Description** and **Extended Description** fields (not required) to add other information about the taxonomy. When the dialog is complete, click **OK** (otherwise, click **Cancel**).
If the user enters or uses a duplicate taxonomy name, iCare will display a warning that the user might be overwriting the user’s taxonomy. The user can overwrite (Yes), save as another name (No), or Cancel (return to the Create/Update Community Taxonomy dialog).

If using a unique taxonomy name, the application displays the Confirm save to RPMS information message: “The data will be saved to the RPMS server. Do you want to continue?” Click Yes to save the data to the RPMS server (otherwise click No).

After the user clicks Yes, the application displays the Community Taxonomy Create message stating that the community taxonomy was successfully created and that the panel definition will be updated to reflect the use of a taxonomy rather than a list of communities. Click OK to dismiss the message. After the user clicks OK, the list of names will be replaced with the name of the taxonomy, and the By Taxonomy option button will be selected.

**By Taxonomy Option Button**

Use the By Taxonomy option button to define the taxonomies to filter the displayed events. After clicking the Edit button, the application displays the Add/Remove Community Taxonomies dialog.

![Add/Remove Community Taxonomies dialog](image)

Figure 8-11: Add/Remove Community Taxonomies dialog

Section 8.1.3.1.1 provides information on how to use the Available Selections and Current Selections group boxes.

When the Add/Remove Community Taxonomies dialog is complete, click OK. The options in the Current Selections group box determine the default Community by Taxonomy for the Events on the CMET main window. (Otherwise click Cancel.)
8.2 Free Text Fields

Free text fields are fields that users can type information into. This type of field does not have a list from which the user can select an option to populate it.

An example of the Free Text field is the Panel Name field (when creating/editing a panel definition).

There is a context menu to aid in editing the text.

![Context menu](image)

Figure 8-12: Context menu to aid in editing text

These options operate just like those in any Windows application.

**Undo**: Removes the last edit action.

**Cut**: Removes the selected text from its current position and places it on the Windows clipboard.

**Copy**: Copies the selected text and places it on the Windows clipboard (the text is not removed).

**Paste**: Copies the contents of the Windows clipboard and places it in the field at the current cursor position.

**Delete**: Removes the selected text from its current position.

**Select All**: Selects all of the text in the current field.

8.3 Print Preview

The Print Preview window contains several features for reviewing and printing the current document.
The **Print Preview** window contains two panels: The left panel displays the pages in the document, and the right panel displays a larger version of the page selected in the left panel.

Table 8-1 provides information on the various buttons on the **Print Preview** window.

**Table 8-1: Print Preview dialog buttons and descriptions**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Print symbol]</td>
<td>Prints the document. This function is also available by selecting <strong>Print</strong> from the <strong>File</strong> menu.</td>
</tr>
<tr>
<td>![Hand Tool symbol]</td>
<td>Changes the display of the selected page in the right panel. Navigate the hand tool to change the page selection (red box) in the left panel. This function is also available by selecting <strong>Hand Tool</strong> from the <strong>Tools</strong> menu.</td>
</tr>
<tr>
<td>![Snapshot Tools symbol]</td>
<td>Click for a screen capture of a specified rectangular area. The screen capture copies to the Windows clipboard. Paste the copy into a particular field or another application like Microsoft Word. This function is also available by selecting <strong>Snapshot Tools</strong> from the <strong>Tools</strong> menu.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="icon1.png" alt="Icon" /></td>
<td>Specify the zoom magnification. Click the button and move to the area to magnify or minimize. Right-click on the area and select the zoom magnification option from the context menu. This function is also available by selecting <strong>Dynamic Zoom Tool</strong> from the <strong>Tools</strong> menu.</td>
</tr>
<tr>
<td><img src="icon2.png" alt="Icon" /></td>
<td>Zooms out and decreases image view size. This function is also available by selecting <strong>Zoom Out</strong> from the <strong>View</strong> menu.</td>
</tr>
<tr>
<td><img src="icon3.png" alt="Icon" /></td>
<td>Zooms in and enlarges the image view. This function is also available by selecting <strong>Zoom In</strong> from the <strong>View</strong> menu.</td>
</tr>
<tr>
<td><img src="icon4.png" alt="Icon" /></td>
<td>Displays the image in the right panel at its maximum page width (usually enlarges the image). This function is also available by selecting <strong>Page Width</strong> from the <strong>View</strong> menu.</td>
</tr>
<tr>
<td><img src="icon5.png" alt="Icon" /></td>
<td>Displays the image in the right panel with page margins hidden. This function is also available by selecting <strong>Margin Width</strong> from the <strong>View</strong> menu.</td>
</tr>
<tr>
<td><img src="icon6.png" alt="Icon" /></td>
<td>Displays the page with page margins in the right panel. This function is also available by selecting <strong>Whole Page</strong> from the <strong>View</strong> menu.</td>
</tr>
<tr>
<td><img src="icon7.png" alt="Icon" /></td>
<td>Zooms out of image in the right panel. Also available by selecting <strong>Zoom Out</strong> from the <strong>View</strong> menu.</td>
</tr>
<tr>
<td><img src="icon8.png" alt="Icon" /></td>
<td>Zooms into image in the right panel. This function is also available by selecting <strong>Zoom In</strong> from the <strong>View</strong> menu.</td>
</tr>
<tr>
<td><img src="icon9.png" alt="Icon" /></td>
<td>Displays all pages in the right panel. This function is also available by selecting <strong>Continuous</strong> from the <strong>View</strong> menu.</td>
</tr>
<tr>
<td><img src="icon10.png" alt="Icon" /></td>
<td>Click to specify the page layout. This function is also available by selecting <strong>Page Setup</strong> from the <strong>File</strong> menu.</td>
</tr>
</tbody>
</table>

Move through the pages in the document by using the arrow buttons on the second line in the toolbar.

![Figure 8-14: Document navigation buttons](image.png)

The same options are available by selecting **View** | **Go To** (and also on the context menu for the right panel).

Use the **Zoom** field (or select **Zoom** from the **View** menu) to specify the zoom magnification for the right panel by selecting from the list.

Click the **Close** button to close the **Print Preview** dialog or select **File** | **Exit**.

Select **File** | **Page Setup** to access the **Page Setup** dialog.
Specify the paper size and source in the Paper group box.

Specify the page orientation in the Orientation group box.

Specify the document margins in the Margins (inches) group box.

Click Printer to access the Printer dialog and select the printer to print the document.

After the Page Setup dialog is complete, click OK to save the page setup options. (Otherwise, click Cancel.)

8.4 iCare Package Manager Functions

Users with the Package Manager security key can access Manager functions by selecting Tools | iCare Package Manager on the iCare main window.
8.4.1  iCare User Access Management

The iCare User Access Management option accesses **iCare User Access Management** dialog.

![iCare User Access Management dialog](image)

Figure 8-17: **iCare User Access Management** dialog

Users with appropriate permissions can assign roles to a particular user. Scroll to the name on the **iCare User Access Maintenance** dialog and select the appropriate check boxes for the roles. To remove an assigned role, deselect the corresponding check box.

When this dialog is complete, click **OK** to save changes. (Otherwise, click **Cancel**.)

**Note:** The **BH User** column cannot be changed.

Each column heading has hover help.

Some check boxes are checked, and the background is dark if the user has iCare Package Manager access that supersedes both CMET and Editor permissions. The Employer and Behavioral Health (BH) permissions work differently due to the sensitive nature of the patients involved.

8.4.1.1  Existing RPMS Editor Access

The users displayed on this list (those with the iCare user icon [ ] in the first column) have Editor or Manager level key(s) to at least one of the following case management applications:

- Case Management System (ACM)
- Diabetes Management System (BDM)
- HIV Management System (BKM)
- Immunization (BI)
- Patient Chart Problem List
- Women’s Health (BW)

### 8.4.1.2 Help Menu

Click the **Help** menu to view the following information:

The users displayed on this list have basic access to the iCare application by the Site (IT) Manager. You cannot give Editor or Package Manager access to iCare to a user who does not have basic access. See your Site Manager to require basic iCare access for other users.

This message applies to the **User with iCare Access** column. Click **OK** to dismiss the message.

### 8.4.1.3 Users with iCare Access

This column is a list of RPMS users who have been given access to the iCare application by the Site (IT) Manager.

### 8.4.1.4 iCare Package Manager

The iCare Package Manager has all read/write access as defined for other user levels. This person can do the following:

- Assign all other access roles in iCare: iCare Package Managers; CMET Package Managers, Editors, and Taxonomy Editors.
- Access Patient Information associated with Community Alerts.
- Has all read/write access as defined for other user levels.
- Reassign existing iCare panels to iCare users.

**Note:** Taxonomy Editor Access Management is assigned through the **Taxonomy Maintenance/ Taxonomy User Access** window from the **Tools** menu.

The iCare Package Manager has the highest level of permissions; hence, the iCare Package Manager will have access to all items accessible by the CMET Package Manager.

The iCare Package Manager does everything an editor does and also has the ability to access the list of patients who have triggered the Community Alerts. This person also assigns Editor access to other users. In addition, this person can assign the CMET Package Manager role.
8.4.1.5  **CMET Package Manager**

The CMET Package Manager has the ability to establish the CMET site parameters related to Tickler Timeframes and Batch Processing. CMET Package Managers have all read/write access as defined for other user levels.

8.4.1.6  **Editors**

Editors in iCare have read/write access to:

- PCC Historical Data Entry
- Care Management data
- Family History and Reproductive Factors (Snapshot)
- Designated Specialty Provider Management system (DSPM)
- Problem List
- CMET Worksheet

The Editor role grants permission to edit the care management function (e.g., **HMS Care Management**) and allows **Historical Data** entry.

8.4.1.7  **Employer Group Access**

Employer Group Access gives the user the ability to define a panel based on the **Employer** option in Panel Definition. They will also have visibility for the **Employee Health** option on the **Panel View: Care Mgmt** tab. Both the definition and **Care Mgmt** feature will not be visible to users who do not have permission.

8.4.1.8  **BH Alerts**

Exclude non-BH alerts.

8.4.1.9  **BH User**

User with existing BH access. This cannot be edited from iCare screens.

8.4.1.10  **IPC Package Manager**

The IPC Package Manager has the ability to establish site parameters related to the background job and microsystem definition for IPC tabs in iCare.

8.4.1.11  **DSPM Editor**

The DSPM (Designated Specialty Provider Management) Editor gives a user permission to use **Update DPCP** (Update DPCP) on panels.
8.4.2 Reassign Panels

The Reassign Panels option displays the Reassign Panels dialog.

![Reassign Panels dialog](image)

Figure 8-18: Reassign Panels dialog

This dialog allows the iCare Package Manager to reassign panels from one user to another user.

**Reassign From**: Select the user from whom the panels are to be reassigned from the list.

**Reassign To**: Select the user to whom the panels are to be reassigned from the list.

Populating the first two fields activates the Select button. Click Select to access the Add/Remove Panels dialog.

![Add/Remove Panels dialog](image)

Figure 8-19: Add/Remove Panels dialog
After the Add/Remove dialog is complete, click OK. The panels listed in the Current Panels group box will populate the Panels field on the Reassign dialog. (Otherwise, click Cancel).

After the Reassign Panels dialog is complete, click OK, and the reassigned panels of the Reassign From user are removed from that person’s panel view. The reassigned panels will appear in the Reassign To user panel view. (Otherwise, click Cancel.)

8.5 iCare Taxonomy View/Edit

The iCare Taxonomy Editor holds the security key (BQIZTXED), which allows that user to read/edit iCare taxonomies.

Access the iCare Taxonomy View/Edit dialog by selecting Tools | Taxonomy Maintenance | View/Edit Taxonomy Entries on the main iCare Tools menu.

![iCare Taxonomy View/Edit dialog](image)

Figure 8-20: iCare Taxonomy View/Edit dialog
**Note:** Only users with the appropriate security key can view the information on the dialog. The following information message displays: “You do not currently have access rights to edit taxonomies.” Users requiring access need to have the iCare Taxonomy Editor security key (BQIZTXED) added to their RPMS user account.

When first accessing this view/edit dialog, all parts of the tree structure will be collapsed. Expand the tree parts to find the desired taxonomy.

In general, select the taxonomy from the list in the left group box. This causes the **Add** and **Remove** buttons to display in the right group box of the dialog.

Please note that not all taxonomies can be edited. iCare will display a message on the view/edit dialog for these taxonomies. Site-populated taxonomies can only be edited by users with appropriate access.

Use the **Apply** button when adding more than one taxonomy value to the iCare Taxonomy View/Edit dialog.

### 8.5.1 Add Taxonomy Values

Click the **Add** button to create values for a selected item in the left group box. The application displays the **Select Taxonomy Item** dialog.

![Select Taxonomy Item dialog](image)

**Figure 8-21: Select Taxonomy Item dialog**
Use the **Search** field to search for a taxonomy item. Highlight the item to add and click **Select**. The application checks for an existing record.

- If the item already exists, a warning message displays. Click **OK** to dismiss the message and return to the **iCare Taxonomy View/Edit** dialog.
- If the item does not exist in the system, it appends the selected item to the bottom of the list.

If there are no more taxonomy values to add, click **Apply** to save changes. Attempting to move to another taxonomy or another part of the iCare application before clicking **Apply** will result in the **Taxonomy changes?** information message displaying. The message will ask whether to apply the changes. Click **Yes** to apply the changes (otherwise, click **No**).

If needed, repeat adding items to various taxonomies. When finished using the **iCare Taxonomy View/Edit** dialog, click **OK** to save (otherwise, click **Cancel**).

### 8.5.2 Remove Taxonomy Values

To remove one or more items from the list, highlight the item(s) and click **Remove**. The **Confirm taxonomy item remove message** displays. Click **Yes** to remove the items (otherwise, click **No**) and remain on the **iCare Taxonomy View/Edit** dialog.

### 8.5.3 View Report of All Taxonomies Button

Click the **View Report of All Taxonomies** button to display the **Taxonomy Report** pop-up.

![Taxonomy Report pop-up](image)

**Figure 8-22: Taxonomy Report pop-up**
This pop-up provides information about various Taxonomy Categories (listed in alphabetical order).

See Section 8.6 for information about the **File** menu and buttons on the pop-up.

### 8.6 Pop-up Functionality

Several functions in iCare result in displaying a pop-up. For example, double-clicking on any row in the **Recent Visits** group box on the **Cover Sheet** of the **Patient Record** window results in viewing a pop-up.

![Visit Detail pop-up](image)

Figure 8-23: **Visit Detail** pop-up

Take the following actions on this pop-up:

- Navigate through the information by using the scroll bar.
- Click the **Find** button to access a search tool to find data in the current window. This button works like the **Search** button.
- Click the **Font** button to display the **Font** dialog.
Use this dialog to change the Font name, style, and size (applies to all of the text). Additional effects like Strikeout and Underline are also available in this form and perform like those effects in Microsoft Word.

Change the Script option to see the text displayed in another language, if that language pack is installed on the computer. If the language pack is not installed, the display will not change by selecting another script.

Click OK to apply changes to the text in the current pop-up. These changes are only effective for the current view of the pop-up. (Otherwise, click Cancel.)

- Click the Copy (Copy) button to copy the selected text to the Windows clipboard.
- Click the Print Preview (Print Preview) button to view the Print Preview dialog (see Section 8.3 for details). Print the pop-up contents from this dialog.
- Click the Print ( ) button to display a print dialog to specify the printer, the page range, and number of copies.

The File menu contains the print actions (like the Print Preview and Print buttons), the Page Setup function, the Find and Copy functions, as well as a Close function, which dismisses the pop-up.
8.7 Taxonomy User Access

Editing site-populated taxonomies can affect many existing processes in RPMS. For this reason, Taxonomy Edit access is carefully assigned to a limited number of users and only after discussion with the CRS (GPRA) coordinator.

Select Tools | Taxonomy Maintenance | Taxonomy User Access to access the iCare Taxonomy User Access Management dialog.

![iCare Taxonomy User Access Management](image)

Figure 8-25: iCare Taxonomy User Access Management for Taxonomy Editor

Each of the column headings has hover help.

8.7.1 Existing RPMS Editor Access

The users with the iCare user icon ( ) in first column are RPMS users with existing Manager level keys to at least one of the following applications: CRS (BGP), Diabetes Management (BDM), HIV Management System (BKM), and/or Women’s Health (BW).

8.7.2 Users with iCare Access

This column is a list of RPMS users who have been given access to the iCare application by the Site (IT) Manager.
8.7.3 Taxonomy Editor

Users with a check mark in the Taxonomy Editor column are taxonomy editors who can add and delete members from any Site Populated Taxonomies related to either laboratory tests or medications.

8.7.4 Help Menu

The following information displays after clicking the Help menu:

The users displayed on this list have been given basic access to the iCare application by your Site (IT) Manager. You cannot give Editor or Package Manager access to iCare to a user who doesn’t have basic access. See your Site Manager to acquire basic iCare access for other users.

8.8 Change RPMS Server/Login

The Change RPMS Server/Login option displays on the File menu. Select this option to access the iCare Login dialog.

![iCare Login dialog](image)

Figure 8-26: iCare Login dialog

**RPMS Server**

Click the list to access the RPMS Server Management dialog that displays a list of possible connections.
Select an option on the grid. To create a new connection, click the **New** button, which opens the **Edit RPMS Server Connection** dialog.

*Do not* select the **Default RPMS Server Connection** or **Use Windows Authentication** check boxes.

**Connection Name**

Type the name of the connection in this field. This is the name that will appear on the **RPMS Server Connection Management** dialog.
Server Address/Name
Type the number, including punctuation, of the server’s IP address. An IP address is typically four groups of two or three numbers, separated by a period (.), e.g., 999.999.99.999. The Site Manager will provide this information.

Server Port
Type the number of the server port. The Site Manager will provide this information.

Server Namespace
If the user’s site has multiple databases on one server, the user will also need to type the namespace, which is typically a text string, e.g., DEVEH.

Use default namespace
Select this check box to use the Server Namespace as the default.

After completing the fields, the Test Connection button becomes active. Click this button to access the Test Login dialog. Populate the Access Code and Verify Code fields and click OK.

- After clicking OK, if the connection is correct, the application displays the Connection Test message: “RPMS login was successful.” Click OK to dismiss the message.
- Otherwise, the application will display an error message; click OK to return to the Test Login dialog.

After the Edit RPMS Server Connection dialog is complete, click OK to have the server connection display on the RPMS Server Connection Management dialog. Otherwise, click Cancel.

After the RPMS Server Connection Management dialog is complete, click Save (otherwise, click Cancel).

After clicking Save, the application displays the login dialog to the application.

8.9 iCare Site Parameter Options
Access the iCare Site Parameters on the Tools menu.
Use the **CMET Site Parameters** option to determine the **Tickler Timeframes** and **Batch Processing** for CMET. Select the **CMET Site Parameters** option to access the **RPMS iCare – CMET Site Parameters** dialog.

**Tickler Timeframes**

The **Tickler Timeframes** tab sets the Ticklers (reminder notices) for **Findings**, **Follow-up Decision**, and **Patient Notification**.

Each field has a list from which to select an option. When a time frame date is passed, and the step has not been entered, the Tickler will display.

After changing one or more settings and clicking **OK**, the application populates the **Last Edited** field with the date and the **By** field with the person who changed the **Tickler Timeframe** data. (Otherwise, click **Cancel**.)
The application provides Ticklers designed to remind the user that a CMET is tracked and requires attention. There are three types of Ticklers:

- **Finding Ticklers** are based on the event date. The Tickler is initiated from the date of the event.
- **Follow-up Decision Ticklers** are initiated from the date the Findings are entered.
- **Patient Notification Ticklers** are initiated from the date the Follow-up recommendation is entered.

Time frames for each of the three steps is based on the preceding step. For example, a Follow-up Decision Tickler is based on the date the Finding is entered.

**Batch Processing Tab**

The **Batch Processing** tab sets the time frame and notification type for the Pap Smear and Mammogram Screening events with normal results. In addition, the type of **Normal Finding for the Mammogram Screening** event is set on this tab.

![Batch Processing tab](image)

**Figure 8-31:** Batch Processing tab

The **Notification Type** field defines how the patient will be notified about the Pap Smear or Mammogram Screening, for example, by telephone. The default is **Letter**.

The **Timeframe** consideration is based on typical (or average) length of time it would take to receive results, to consider the next steps, and to notify the patient.

The option selected for the **Normal Finding for Mammogram Screening** field determine what is a normal finding.
Each field has a list from which to select an option.

After the user changes one or more settings and clicks **OK**, the application populates the **Last Edited** field with the date and the **By** field with the person who changed the batch processing data. (Otherwise, click **Cancel**.)

**Events**

The **Events** tab allows users to edit a manual event default value.

![Events tab](image)

Figure 8-32: **Events** tab

Double-click on an event in the grid to populate the bottom of the form. Select the **PCC File** value and then the **Default Value** for the event. Click the **Save** button.

### 8.10 Manage Templates

The **Manage Templates** option provides a means for defining multiple template layouts. Templates can also be created and added so that anyone can download and use them.

The **Manage Templates** option appears on the **Tools** menu. Select it to access the **Template Management** dialog.
Figure 8-33: Template Management dialog

The Your Templates group box contains a list of all of a specific user’s defined templates and the layout contained in each template.

The Public Templates group box contains a list of all templates at the site that are available to be downloaded to the list in Your Templates.

8.10.1 View
Use the View action to view a selected template. This is a view-only display.

8.10.2 Upload
The Upload action is available in the Your Template group box. Select a template to upload and then click Upload. The selected template will appear in the Public Templates group box. The author will be you (the person who executed the Upload).

8.10.3 Download
The Download action is available in the Public Templates group box. Select a record to download and click Download. The selected template will display in the Your Templates group box. In the Template field, your name (the person who executed the download) will display after the name of the template.
8.10.4 Delete

The **Delete** action is available in the **Your Templates** and **Public Templates** group boxes and applies to your templates only. Select a record to delete and click **Delete**. The **Delete Template** information message displays confirming the deletion. Click **Yes** to delete (otherwise, click **No**.)

8.10.5 Edit

The **Edit** action is available in the **Your Templates** group box. Select a template to edit and click **Edit**. Access the columns for the selected template. Section 8.10.6.1 provides information about how to use this feature.

8.10.6 Add

The **Add** action is available in the **Your Templates** group box. Click **Add** to access the **Add Template** dialog.

![Add Template dialog](image)

Figure 8-34: **Add Template** dialog

**Layout**: Select an option from the **Layout** list to specify which layout to use for the new template.

**Template Name**: Type the name of the template in this Free Text field, which is limited to 80 characters and must contain at least one alpha character.

After the dialog is complete, click **Add** to access the template to define the columns and column sort for the new template. (Otherwise, click **Exit**.)
Click the **Reset to System Default** button to reset the template to the system default.

To discard changes, click **Reset**.

After the template window is complete, click **OK** and the new template will appear in the **Your Templates** group box. (Otherwise, click **Cancel**.)

### 8.10.6.1 Display and Available Columns

Use the **Display Columns** to determine which columns to display for the particular window or tab.
The listing in the **Display Columns** area shows the columns that will be displayed for your template. The column names in italics are required and cannot be removed.

To move a highlighted column name in the **Available Columns** area to the list in the **Display Columns** area, click **Add**. This moves the column name from the left panel to right panel.

Likewise, remove a highlighted column name in the **Display Columns** area and move it to the **Available Columns** area by clicking **Remove**. This moves the column name from the right panel to the left panel.

**Note:** Column names in italics are required and cannot be removed.

Determine the order the columns display in the **Display Columns** area by using the **Up** and **Down** buttons. Highlight a column name and click the appropriate button. Moving an item to the desired location may involve clicking the button more than once.

### 8.10.6.2 Columns to Sort

Sorting a column arranges the column items in alphanumerical order.
To move a selected column name from the Available Sorts area to the list in the Sort Columns area, click Add. This moves the column name from the left panel to right panel.

Likewise, remove a selected column from the Sort Columns area and move it to the Available Sorts area by clicking Remove. This moves the column name from the right panel to the left panel.

**Note**: Column names in italics are required and cannot be removed.

### 8.10.6.3 Column Sort Order

Use the Sort Columns area to determine which columns to sort for the particular window or tab.

Determine the order in which the columns are sorted in the Sort Columns area by using the Up and Down buttons. Select a column name and click the appropriate button. It may require clicking the button more than once to move an item to the desired location. For example, if **Gender**, **Patient Name**, and **Diagnosis Tags** are in the right column, the **Gender** sort is applied first, then the **Patient Name**, and the **Diagnosis Tags** sort is applied last.

### 8.10.6.4 Switch Sort Direction

The names of columns in the Sort Columns area display “ASC” appended to the name, for example, **Patient Name ASC**. Switch the sort order for a selected column by clicking the Switch Sort Direction button. In the example, the name changes to **Patient Name DESC**. Use the Switch Sort Direction action on more than one column.
Appendix A: Care Management Events

A.1 BREAST

A.1.1 BREAST AUGMENTATION
BTPW BRST AUG PROC ICD Procedure

A.1.2 BREAST MRI
BTPW BRST MRI CPTS CPT Procedure
BTPW BRST MRI PROC ICD Procedure

A.1.3 BREAST RECONSTRUCTION W/IMPLANTS
BTPW BRST RECON W/ IMP CPTS CPT Procedure
BTPW BRST RECON W/IMP PROCS ICD Procedure
BTPW BRST RECON W/IMP DXS POV

A.1.4 BREAST RECONSTRUCTION W/OUT IMPLANTS
BTPW BRST RECON W/O IMP CPTS CPT Procedure
BTPW BRST RECON W/O IMP PROC ICD Procedure

A.1.5 BREAST RECONSTRUCTION, UNSPECIFIED
BTPW BRST RECON UNS PROC ICD Procedure

A.1.6 BREAST REDUCTION
BTPW BRST REDUC CPTS CPT Procedure
BTPW BRST REDUC PROC ICD Procedure

A.1.7 BREAST ULTRASOUND
BTPW BRST ULTRA-SND CPTS CPT Procedure
BTPW BRST ULTRA-SND PROC ICD Procedure

A.1.8 CENTRAL DUCT EXCISION
BTPW CENTRAL DUC EXC CPTS CPT Procedure
### A.1.9 CLINICAL BREAST EXAM
- **BTPW CLIN BRST EXAM PROC**  |  ICD Procedure
- **BTPW CLIN BRST EXAM DXS**   |  POV
- **BTPW CLIN BRST EXAM CPTS**  |  CPT Procedure

### A.1.10 DUCTOGRAM
- **BTPW DUCTOGRAM CPTS**      |  CPT Procedure
- **BTPW DUCTOGRAM PROC**      |  ICD Procedure

### A.1.11 FINE NEEDLE ASPIRATION
- **BTPW FINE NEEDLE ASP CPTS** |  CPT Procedure
- **BTPW FINE NEEDLE ASP PROC** |  ICD Procedure

### A.1.12 LUMPECTOMY
- **BTPW LUMPECTOMY CPTS**     |  CPT Procedure
- **BTPW LUMPECTOMY PROC**     |  ICD Procedure

### A.1.13 MAMMOGRAM DX BILATERAL
- **BTPW MAMMOGRAM BI DX CPTS**|  CPT Procedure

### A.1.14 MAMMOGRAM DX UNILATERAL
- **BTPW MAMMOGRAM UNI DX CPTS**|  CPT Procedure

### A.1.15 MAMMOGRAM SCREENING
- **BTPW MAMMOGRAM SCREEN CPTS** |  CPT Procedure
- **BGP MAMMOGRAM ICDS**       |  POV

### A.1.16 MAMMOGRAM, UNSPECIFIED
- **BGP MAMMOGRAM PROCEDURES** |  ICD Procedure

### A.1.17 MASTECTOMY, BILATERAL (W/BI MOD .50)
- **BTPW BI MASTECTOMY CPTS**  |  CPT Procedure
- **BGP MASTECTOMY PROCEDURES** |  ICD Procedure
A.1.18  MASTECTOMY, UNILATERAL
BTPW UNI MASTECTOMY CPTS  CPT Procedure
BGP UNI MASTECTOMY PROCEDURES  ICD Procedure

A.1.19  MASTECTOMY, UNSPECIFIED
BTPW MASTECTOMY UNS CPTS  CPT Procedure

A.1.20  NEEDLE BIOPSY
BTPW NEEDLE BX CPTS  CPT Procedure
BTPW NEEDLE BX PROC  ICD Procedure

A.1.21  NEEDLE BIOPSY, GUIDED
BTPW NEEDLE BX GUIDED CPTS  CPT Procedure

A.1.22  NODE DISSECTION, AXILLARY
BTPW AX NODE DISECT CPTS  CPT Procedure
BTPW AX NODE DISECT PROC  ICD Procedure

A.1.23  NODE DISSECTION, SENTINEL
BTPW SENT NODE DISECT CPTS  CPT Procedure
BTPW SENT NODE DISECT PROC  ICD Procedure

A.1.24  OPEN BIOPSY
BTPW OPEN BREAST BX CPTS  CPT Procedure
BTPW OPEN BREAST BX PROC  ICD Procedure

A.1.25  STEREOTACTIC BIOPSY
BTPW STEREO BX CPTS  CPT Procedure

A.2  CERVICAL

A.2.1  COLPOSCOPY IMPRESSION
BTPW COLP IMP NO BX CPTS  CPT Procedure
BTPW COLP IMP NO BX PROC  ICD Procedure
A.2.2  COLPOSCOPY W/ BIOPSY
BTPW COLP WITH BX CPTS  CPT Procedure
BTPW COLP WITH BX PROC  ICD Procedure

A.2.3  CONE BIOPSY
BTPW CONE BX CPTS  CPT Procedure
BTPW CONE BX PROC  ICD Procedure

A.2.4  CRYOTHERAPY
BTPW CRYOTHERAPY CPTS  CPT Procedure
BTPW CRYOTHERAPY PROC  ICD Procedure

A.2.5  DILATION AND CURETTAGE
BTPW D&C CPTS  CPT Procedure
BTPW D&C PROC  ICD Procedure

A.2.6  ENDOCERVICAL CURETTAGE
BTPW ENDOCERVICAL CURR CPTS  CPT Procedure
BTPW ENDOCERVICAL CURR PROC  ICD Procedure

A.2.7  ENDOMETRIAL BIOPSY
BTPW ENDOMETRIAL BX CPTS  CPT Procedure
BTPW ENDOMETRIAL BX PROC  ICD Procedure

A.2.8  HPV - DNA SCREEN
BTPW HPV DNA SCREEN CPTS  CPT Procedure
BTPW HPV DNA SCREEN DXS  POV
BTPW HPV DNA SCREEN LOINC  LAB (LOINC)
BTPW HPV DNA SCREEN TAX  LAB

A.2.9  HYSTERECTOMY
BGP HYSTERECTOMY CPTS  CPT Procedure
BGP HYSTERECTOMY PROCEDURES  ICD Procedure
A.2.10 LASER ABLATION
BTPW LASER ABLATION CPTS  CPT Procedure
BTPW LASER ABLATION PROC  ICD Procedure

A.2.11 LASER CONE
BTPW LASER CONE CPTS  CPT Procedure
BTPW LASER CONE PROC  ICD Procedure

A.2.12 LEEP
BTPW LEEP CPTS  CPT Procedure
BTPW LEEP PROC  ICD Procedure

A.2.13 PAP SMEAR
BGP CPT PAP  CPT Procedure
BQI PAP PROCEDURES  ICD Procedure
BGP PAP LOINC CODES  LAB (LOINC)
BGP PAP SMEAR TAX  LAB

A.2.14 PELVIC EXAM
BTPW PELVIC EXAM CPTS  CPT Procedure
BTPW PELVIC EXAM PROC  ICD Procedure
BTPW PELVIC EXAM DXS  POV

A.2.15 PELVIC ULTRASOUND
BTPW PELVIC U/S CPTS  CPT Procedure
BTPW PELVIC U/S PROC  ICD Procedure

A.2.16 PERIANAL BIOPSY
BTPW PERIANAL BX CPTS  CPT Procedure
BTPW PERIANAL BX PROC  ICD Procedure

A.2.17 VAGINAL ULTRASOUND
BTPW VAGINAL U/S CPTS  CPT Procedure
### A.3 COLON

#### A.3.1 COLONOSCOPY
- BTPW COLONSCOPY CPTS (CPT Procedure)
- BGP COLO PROC (ICD Procedure)

#### A.3.2 DOUBLE CONTRAST BARIUM ENEMA
- BGP BE CPTS (CPT Procedure)

#### A.3.3 FECAL OCCULT BLOOD TEST (FOBT)
- BGP FOBT CPTS (CPT Procedure)
- BGP FOBT LOINC CODES (LAB (LOINC))
- BGP GPRA FOB TESTS (LAB)

#### A.3.4 FLEXIBLE SIGMOIDOSCOPY
- BTPW SIGMOID CPTS (CPT Procedure)
- BGP SIG PROC (ICD Procedure)

### A.4 LIVER

#### A.4.1 Hepatitis C Confirm
- BQI HEP C CONFIRM LOINC CODES (LAB (LOINC))
- BQI HEP C CONFIRM TESTS (LAB)

#### A.4.2 Hepatitis C Genotype
- BQI HEP C GENOTYPE LOINC (LAB (LOINC))
- BQI HEP C GENOTYPE TESTS (LAB)

#### A.4.3 Hepatitis C Screen
- BQI HEP C SCREEN LOINC CODES (LAB (LOINC))
- BQI HEP C SCREEN TESTS (LAB)

### A.5 SKELETAL
A.5.1 OSTEOPOROSIS SCREENING - DXA CENTRAL
BTPW DXA CENTRAL CPTS CPT Procedure

A.5.2 OSTEOPOROSIS SCREENING - GENERAL
BTPW OSTEO SCREEN PROC ICD Procedure
BTPW OSTEO SCREEN DXS POV

A.5.3 OSTEOPOROSIS SCREENING - PERIPHERAL DXA
BTPW PERIPH DXA CPTS CPT Procedure

A.5.4 OSTEOPOROSIS SCREENING - QUANTITATIVE CT
BTPW QUAN CT CPTS CPT Procedure

A.5.5 OSTEOPOROSIS SCREENING - QUANTITATIVE ULTRASOUND
BTPW QUAN U/S CPTS CPT Procedure

A.6 STI

A.6.1 CHLAMYDIA SCREEN
BTPW CHLAMYDIA CPTS CPT Procedure
BQI CHLAMYDIA SCREEN DXS POV
BGP CHLAMYDIA LOINC CODES LAB (LOINC)
BGP CHLAMYDIA TESTS TAX LAB

A.6.2 GONORRHEA SCREEN
BKM GONORRHEA TESTS CPTS CPT Procedure
BKM GONORRHEA LOINC CODES LAB (LOINC)
BKM GONORRHEA TEST TAX LAB

A.7 PROSTATE

A.7.1 Prostate Screen
BQI PROSTATE SCRN CPTS CPT Procedure
<table>
<thead>
<tr>
<th>BQI PSA LOINC CODES</th>
<th>LAB (LOINC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BQI PSA TEST</td>
<td>LAB</td>
</tr>
</tbody>
</table>

**A.7.2 Prostate Biopsy**

| BQI PROSTATE BIOPSY CPTS | CPT Procedure |

**A.7.3 Prostate Ultrasound**

| BQI PROSTATE ULTRASOUND CPTS | CPT Procedure |


Glossary

Context Menu
The menu of options that displays when right-clicking on an entity.

Designated Primary Care Provider
In RPMS, the provider name that is assigned as the primary care physician for a patient or group of patients at a specific facility. This is not a required function.

Free Text Field
A field where the user can type text, just like typing a note to someone.

iCare Package Manager
The designated person with authority to manage all information settings for iCare.

Providers
Any staff member in an I/T/U facility who provides direct healthcare to patients, e.g. general practice or specialty physicians, registered nurses, social workers, physician assistants, etc.

Taxonomy
In RPMS, a grouping of functionally related data elements, such as ICD codes, that are created and maintained within the RPMS Taxonomy Setup application. Taxonomies will be used as definitions for diagnoses, procedures, lab tests, medications, and other clinical data types.

To change or add to an existing taxonomy, please see a CRS coordinator.

Tooltip/Hover Help
A common GUI element used to provide additional information to users. To display a Tooltip, hover the mouse pointer, without clicking, over a column heading or field.
## Acronym List

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Term Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>BH</td>
<td>Behavioral Health</td>
</tr>
<tr>
<td>CMET</td>
<td>Care Management Event Tracking</td>
</tr>
<tr>
<td>CPT</td>
<td>Current Procedural Terminology</td>
</tr>
<tr>
<td>CQM</td>
<td>Clinical Quality Measures</td>
</tr>
<tr>
<td>CRS</td>
<td>Clinical Reporting System</td>
</tr>
<tr>
<td>DOB</td>
<td>Date of Birth</td>
</tr>
<tr>
<td>DPCP</td>
<td>Designated Primary Care Provider</td>
</tr>
<tr>
<td>DSPM</td>
<td>Designated Specialty Provider Management</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>HHS</td>
<td>Health and Human Services</td>
</tr>
<tr>
<td>HRN</td>
<td>Health Record Number</td>
</tr>
<tr>
<td>ICD</td>
<td>International Classification of Diseases</td>
</tr>
<tr>
<td>IHS</td>
<td>Indian Health Service</td>
</tr>
<tr>
<td>IPC</td>
<td>Improving Patient Care</td>
</tr>
<tr>
<td>I/T/U</td>
<td>Indian, Tribal, and Urban</td>
</tr>
<tr>
<td>LOINC</td>
<td>Logical Observation Identifiers Names and Codes</td>
</tr>
<tr>
<td>OIT</td>
<td>Office of Information Technology</td>
</tr>
<tr>
<td>PM</td>
<td>Performance Measures</td>
</tr>
<tr>
<td>RPMS</td>
<td>Resource and Patient Management System</td>
</tr>
<tr>
<td>STI</td>
<td>Sexually Transmitted Infection</td>
</tr>
<tr>
<td>TIU</td>
<td>Text Integration Utilities</td>
</tr>
</tbody>
</table>
Contact Information

If you have any questions or comments regarding this distribution, please contact the OIT Help Desk (IHS).

Phone: (888) 830-7280 (toll free)
Web: http://www.ihs.gov/helpdesk/
Email: support@ihs.gov